
Action! 3.0 Help is an on-line reference guide to all Action commands, windows, and palettes.

The Contents screen on the left gives an overview of the information in Action! 3.0 Help.

Navigating through the help system

To find information you need, click green underlined text. This will put the related topic on screen. For 
example, click the following text: More about Using Action! Help 

Green text with dotted underlines presents pop-up information. For example, click the following text: 
Using pop-up topics

In some topics, you can click part of a graphic to bring up related information.



About Action! 3.0 Help

Action! 3.0 Help was written by Jeff Swartz, based on sections from the Action! 3.0 Users Guide. 

Special thanks to Brad Bechtel, Mike Edmunds, Leo Galinsky, Christian Hunt, and Gordon Smith. 
Documentation management by Mary Ann Walsh.

Copyright

Copyright (c) 1994 Macromedia, Inc. All rights reserved. Except for printing out portions of the help 
system for use by the registered owner, the information in this help system may not be copied, 
photocopied, reproduced, translated, or converted to any printed, electronic or machine-readable form 
in whole or part without prior written approval of Macromedia, Inc.

Macromedia, Inc.
600 Townsend Street
San Francisco, CA    94103

Related topic: Action! Help introduction



A pop-up topic

To dismiss this topic, click in the Action! 3.0 help window.

Click outside of the pop-up topic. Do not click on underlined text (or you will jump to the related topic).



Using Action! 3.0 Help

Related topics:Action! Help introduction
About Action! 3.0 Help

 Buttons at the top of the Action! Help window

Click the Index button at the top of the help window to select a topic from an index of terms.

Click the Go Back button at the top of the help window to return to a previously displayed topic.

Click the History button at the top of the help window to see a list of help topics you have viewed.

Click the Search button at the top of the help window to search for instances of a particular word in 
the help system.

 Menus at the top of the Action! Help window

Use the commands in the File menu to print the current topic or to open another Microsoft Viewer 
presentation.

Use the commands in the Edit menu to copy the text of the current topic into the clipboard or to 
create your own reference notes (annotation) about the current topic.

Use the command in the Bookmark menu to create a bookmark for the current topic or to go to a 
topic referenced by a previous bookmark.

Use the commands in the Help menu to find out more about Microsoft Viewer or about Action! 3.0 
Help.



Contents
Click a menu name for information on a menu command:

File
Edit
View
Scene
Template
Arrange
Text
Chart
Window
Help

Click for more information:

Tool palette
Motion palette
Control panel
Timeline
Tool bar
Status bar

Action! Player



File menu

Click a menu command for more information:



New command

Use the New command to create a new Action! presentation.

When you select this command, the New Presentation dialog box appears. 

In the preview window you see a thumbnail picture of the design for the selected template. 

The default selection in the Template Library Descriptions list is Standard which is a library containing a 
basic family of templates with placeholders for text. 

If the template library you want is not listed, click Browse to display a file selector dialog box so you can 
locate it. If you do not want to use a template for your presentation, choose the template named 
"Blank," which is a template library that contains no objects.

Note: By default, Action! looks for template libraries in the TEMPLATE subdirectory in the same 
directory from which Action! was launched. 





Open command

Use the Open command to open an existing Action! presentation.

If you already have an Action! presentation open when you choose this command, and you have made 
changes to that presentation, Action! will ask you if you want to save those changes before opening 
another presentation.



Save command

Use the Save command to save the current Action! presentation. If it is a new presentation, Action! will 
ask you to give it a file name and directory location; otherwise, Action! will use the existing file name 
and location.



Save As command

Use this command to save the current Action! presentation to disk with the file name and directory 
location you provide. 

When saving Action! files, you can save in the following formats (or file types).

ACT--This is the normal file type for Action! presentation files. You should save most of your files 
using the ACT file type extension (such as MYPRES.ACT).

ACP--This is a specialized file type. If you create an Action! presentation that contains a chart, and 
you want to play that presentation using the Action! Player, you must save the file with the ACP file 
type extension (such as MYPRES.ACP). If you attempt to play an ACT presentation that contains a 
chart with the Action! Player, an error message appears and you cannot continue. Also, ACP files 
don't keep a copy of the templates, so they are smaller than ACT files.

STA--Saving an Action! presentation with the STA file type (such as MYPRES.STA), stores the file 
as a "stationary pad." When you subsequently open the file, Action! automatically creates an 
Untitled version of the file. You can make changes to the untitled version without affecting the 
original file.

Related topic: Action! Player



Action! Player

Your Action! package contains a special program called the Action! Player. This program makes it 
possible to freely distribute a presentation without distributing the main Action! program. The 
presentation can then be played on virtually any PC-compatible computer that has Microsoft Windows 
version 3.1 or higher installed.

To play a presentation using the Action! Player:

1. Locate the Action! Player icon.

The Action! installation program places the program in the Macromedia program group.

If you are running the presentation on a computer where Action! was not installed, use the Windows 
File Manager to locate the PLAYACT.EXE application.

2. Double-click the Player icon to start the program.

You can also use the Run command on the Program Manager File menu.

3. After the Player starts, choose Open from the File menu.

The Open File dialog box appears.

4. Locate the file you want to open, select it in the list, then click OK.

After selecting the file and before clicking OK, select Preview to see a thumbnail view of the 
selected presentation.

The opening scene of the presentation appears in the Player window.

Related topic: Action! Player--special considerations



Action! Player--special considerations

If you plan to distribute a presentation along with the Action! Player, consider the following limitations 
and requirements :

- To play the presentation, your audience needs a copy of the presentation saved in the Action! 
Player format (.ACP), and a copy of the Action! Player software.

- If your presentation contains sounds, they will be audible only if the computer system playing the 
presentation is equipped with the necessary hardware--a sound card and optional speakers.

- The Action! Player software can play any presentation saved in Action! versions 1.0, 1.0.1, 2.0, 2.5, 
2.5.1, and 3.0. However, if the presentation contains a chart or a movie, the following conditions 
must be satisfied.

- If the presentation contains a chart, save the file as an .ACP file type. Attempting to play 
an .ACT file that contains a chart results in an error message when the file loads into the 
Player.

- An .ACT file that contains a movie must be accompanied by the appropriate .DLL file to run with 
the Action! Player. If you are using Action! 2.0, save your file in player format.

- Action! does not embed movie files into the presentation file. If your presentation uses movie 
files, include them separately on your distribution media.

- Most Windows computer systems have a standard, but limited set of fonts available. If your 
presentation relies on fonts other than the standards, you should also provide those fonts with 
instructions to install them on the playback system.



Play Presentation command

Use this command to play the entire presentation in full screen view starting with the first scene. 

To stop the presentation once it is playing, press Esc.



Load Template Library command

Use the Load Template Library command to select and load a library of templates to use with the 
current presentation. The Load Template Library dialog box. appears. Select a template library to load, 
or load the Standard template. 

When you select the file in the list, the template file name appears in the lower right corner of the dialog 
box, and the preferred template of the library appears in the preview window.

If the library you want isn't listed, click Browse and use the file selector dialog box to locate the file.

Automatic template replacement

When you load a template library, Action! copies all templates from that library into the presentation. In 
the case of existing presentations, Action! checks to see if any of the newly loaded templates have the 
same name as templates applied to existing scenes. When a match is found, Action! applies the new 
template (with the same name) to the scene. At the end, Action! discards all of the old, replaced 
templates from the presentation.

When making such replacements, Action! always preserves the content of your original scenes. 
However, if you create a presentation without using any templates and then apply a template library to 
that presentation, Action! cannot preserve the content of the original scenes.

Tip: Although applying a different template library to an existing presentation is very easy to do, it is a 
good practice to save your presentation before loading a different template library, in case the results 
are not what you expect.





Make Template Library command

Use this command to save the current set of templates as a library, under the name you provide. The 
Make Template Library dialog box appears.

Enter a name for the library in the File Name text box. 

Enter a descriptive name for the library in the Description text box. The description can be up to 31 
characters in length. The description entered here appears in the New Presentation and Load Template 
Library dialog boxes.

Click Preferred to specify which template in the library is the preferred template. A dialog box appears, 
in which you select a template from a list. The preferred template appears in the Preview window in 
such dialog boxes as the New Presentation and Load Template Library. It is also the template Action! 
uses to create the first scene in a new presentation that uses the template library.

Check the Directories and Drives controls to make sure you are saving the library in the location you 
want.

Tip: To create a new template library by modifying an existing one, load the existing library, make your 
changes, then use the Make Template Library command on the File menu to save the new library under 
a unique name. The Standard template library contains only one, very simple template. To create a new 
template library, start with the Standard template.





Import submenu

Click a command for more information:



Import Picture command

Use this command to import a picture into the current scene or template. The Import Picture dialog box 
includes the following options:

- Use the Drives and Directories controls to locate the picture file to import.

- Choose the type of file to import from the List Files of Type drop-down list. Your selection 
determines which type of files appear in the scrolling list immediately above.

- Select the picture file to import. The name of your selection appears in the File Name text box.

- To see a thumbnail preview of the file, click Preview. If you'd like to browse through the available 
files and see a preview of each one as you select it, select the Always Preview option.

- Specify whether or not to use the color palette associated with the imported picture. To use the file's 
color palette, select Use Palette; otherwise, deselect this option.

The picture you select appears at the center of the current scene and in the front layer. Drag the 
imported picture to the desired position.

Action! gives you the ability to import picture files saved in most common file formats:

Windows Bitmap (.DIB and BMP)
Windows Metafile (.WMF)
Tag Image File Format (.TIF)
Encapsulated Postscript File (.EPS)
Graphics Interchange Format (.GIF)
PC Paintbrush Bitmap (.PCX)
Kodak Photo CD (.PCD)





Import Sound File command

Related topics: Attaching a sound to multiple scenes,
Import CD Audio command

Use this command to import a sound file to use in the scene and/or presentation. When you select this 
command, the Import Sound dialog box appears.

Action! supports the following types of sounds:

- Microsoft WAVE--This is one of the most common types of sound files used in the Windows 
environment. These files normally have a file type extension of .WAV--for example, DING.WAV. The 
Windows software comes with a small selection of WAVE files. You can also find many such sound 
files on bulletin boards, on-line services, and commercial products such as Macromedia's ClipMedia 
selections.

If you have the necessary hardware and software, you can record and store sounds as digitized 
WAVE files. This can be useful for including a voice-over narrative in a presentation, such as when 
distributing the presentation to others or when playing it in a kiosk. However, keep in mind that such 
files can require substantial disk space and computer memory for playback.

- MIDI Files--These files normally have a file type extension of .MID--for example, JAZZ.MID. If you 
have MIDI equipment, you can create your own MIDI files; or you can obtain them from the same 
sources as WAVE files.

When you attach a sound to a scene, the sound is not controlled by any specific object. This lets 
you trigger a sound and have it play for all or part of a scene, or all or part of a presentation.

You can attach a WAVE or MIDI sound, or an audio CD selection to a scene. 





Attaching a sound to multiple scenes

You cannot directly attach a sound to a presentation, but you can have the sound attached to a scene 
play from one scene to the next. This, in effect, provides the same results as attaching a sound to a 
presentation.

To attach a sound to a scene, click the sound tool in the tool palette to display the sound menu.

- To import a WAVE or MIDI sound file, choose Sound File. The Import Sound dialog box appears so 
you can select a sound file. When you click OK, the Edit Sound dialog box appears. 

- To specify a selection from an audio CD, choose CD Audio. When you click OK, the Edit Sound 
dialog box appears.



Import CD Audio command

Specify a selection from an audio compact disc to play in conjunction with a scene or presentation.

Almost all CD-ROM drives have the ability to play audio discs as well as data discs. If the computer 
where you play the presentation has such a drive, you can play a selection from the CD audio disc in 
conjunction with the presentation. Normally, this is far more space efficient than playing a WAVE or 
MIDI file because the selection is not digitized and, therefore, requires no hard disk space or memory to 
play.

Related topic: Import Sound File command



Import Movie command

Related topic: Special movie requirements

Use this command to import a movie into the current scene or template. The Import Movie dialog box 
includes the following options:

- Use the Drives and Directories controls to locate the movie file to import.

- Choose the type of file to import from the List Files of Type drop-down list. Your selection 
determines which type of files appear in the scrolling list immediately above.

- Select a movie file to import. The movie name appears in the File Name text box.

- To see a thumbnail preview of the movie, click Preview. To browse through the available files and 
see a preview of each one as you select it, select Always Preview. Note, however, that this can be 
quite slow with large movies or those on a CD.

- Specify whether or not to use the movie's color palette (available for Macromedia Director and 
QuickTime movies). To use the movie's color palette, select Use Palette; otherwise, deselect this 
option. For AVI, FLC, and FLI movies, the movie's palette is always imported.

When you click OK, the movie appears at the center of the current scene. A movie always plays in the 
front layer of the scene, so it cannot be obscured by other objects. Drag the movie to the desired 
position.

You can import a variety of movie types in Action! presentations:

Macromedia Director--.MMM
Autodesk Animator--.FLI and .FLC
Microsoft Video for Windows--.AVI
QuickTime for Windows--.MOV





Special movie requirements

When you save an Action! presentation into which you have imported one or more movies, Action! does 
not store the movie file within the presentation file. Therefore, if you intend to play the presentation on 
some other machine, or if you intend to distribute the presentation, be sure to also include the original 
movie file or files.

Here are some other things to keep in mind when using movies in an Action! presentation:

- Do not import two separate movies into a scene if they cannot use the same or compatible color 
palettes. The results will be unsatisfactory.

- If you do import two or more movies into a scene, you may want to play only one movie at a time. 
Otherwise performance may not be acceptable.

- A typical movie file might require a significant amount of memory to run, particularly if the movie has 
a sound track. If you import a movie but your computer system does not have sufficient memory 
available, an error message appears and you cannot continue.

- Movies always play in the front layer of the scene, no matter where they might be placed using the 
timeline or other facilities. That is, you cannot place any other object so that it plays in front of a 
movie.



Import Palette command

Use this command to import a Windows palette for use in the current scene or template.



Import Video Overlay command

Related topic: More about video overlays

Use the Import Video Overlay command to create a video overlay.

When you use the command, a square, the video overlay object, appears on the screen. This is where 
the video will appear when it is playing.

You can create special effects using video overlay and different Action! objects. For example, you can 
have a video overlay appear in a line of text or play in a small circle on the edge of the scene. 

To create a special effect:

1. Mask all or part of the video overlay object with an opaque object (such as a square) that isn't 
magenta. This "curtain object" will block the video. You can apply motion and effects to this object 
(using the motion palette), and the video will be blocked based on these motions and effects.

2. Drag a drawing or text object over the curtain object you just created. Change the color of this "see-
through object" to magenta. The see-through object will define the area of the video that will appear 
through the curtain object. You can apply motion and effects to this object (using the motion 
palette), and the video will show through based on these motions and effects.

You need to use the same magenta that is being used by the video overlay object. To view the 
color, drag the video overlay object and as the object redraws, notice the color that appears under 
the black foreground. Because the color is a standard Windows color, look for the magenta color in 
the third square from the end at the bottom of the standard Action! color palette.



More about video overlays

Related topic: Import Video Overlay command

The video overlay feature can be used to show live video images from a VCR, LaserDisc, or television 
output as part of an Action! presentation. The video material plays in real-time only and requires that the 
computer system have a video overlay board installed and configured.

Real-time access to a video cassette recorder (VCR) normally requires a special circuit board installed 
in the computer. Such boards can be obtained from computer resellers.



Import Presentation command

The Import Presentation command gives you the ability to read in one or more presentation slides 
created by a different application (such as Lotus Freelance or Microsoft PowerPoint) and use them in 
Action! as part of a multimedia presentation.

To import them, you must first save each slide of the presentation in the original application in the 
Windows Metafile (.WMF) format.

When you select this command, the Import Presentation dialog box appears. Set the following options:

- Select the Drive and Directory that holds the file to import.

- Select the file or type the file name in the File Name text box. You can select more than one.

- To apply a template to the scenes you are importing, select it from the Templates drop-down list.

- To preview the selected file, click Preview. The two buttons above the preview window (<< and >>) 
can be used to cycle through the selected files.

- Select one of the Import Options:

- Import as One Metafile imports the presentation in its original form. 

- Separate Text Only extracts the text from the presentation. After it is imported, the text exists as 
individual objects. 

- Separate All Objects in Metafile separates the presentation into its individual objects.

- Select one of the Insert Scene Options. 

- At Beginning inserts the new scenes at the beginning of the presentation. 

- After Current Scene inserts the new scenes after the currently selected scene. 

- At End inserts the new scenes after the last scene in the presentation.

Action! treats each .WMF file you import as a new scene. If you are importing more than one file, 
the files are inserted in the same order as they appear in the list of file names. Each file becomes a 
new scene. 





Import Chart Data command

You can import data from other applications (such as Lotus 1-2-3, Microsoft Excel, dBase, and others) 
into the Chart Data Window. The Data Window must be active to use this command.

When you select this command, the Import Data dialog box appears:

- Choose a file type from the List Files of Type drop-down list. This list identifies the various types of 
files you can import. When you choose a file type, only those types of files appear in the File Name 
list.

- Select a file to import and click OK. Action! imports the file into the Data Window. Data from the 
imported file begins filling cells starting at cell A1.



Export command

Saves portions of the current Action! presentation in a format that can be used by other software 
applications. When you select this command, the Export dialog box appears.

The export facility provides a way to use specific snapshots from an Action! scene with other 
applications. You can export them in the following file formats:

- Windows Bitmap (.DIB file extensions). This format can be used with Windows Paint and painting 
applications.

- Windows Metafile (.WMF file extensions). This format can be used with any application that can 
process metafiles.

Whichever file format you choose, the result is one or more files that are individual or still images 
representing a specific time in a given scene.

To use the export feature:

1. Open the presentation containing the scene or scenes you want to export.

2. Locate the scene containing the image or images you want to export.

You can export and save snapshots from only one scene at a time, but you can export multiple 
snapshots--up to 999--from any given scene. You'll learn how this is controlled and specified in a 
later step.

3. Choose Export from the File menu to display the Export dialog box.

4. Use the Drives and Directories controls to move to the location where you want to store the files 
you are exporting.

5. Choose a file format from the List Files of Type drop down list.

Your choice determines which types of existing files Action! shows in the scrolling list immediately 
above. As indicated earlier, you can choose Windows DIB or Windows Metafile.

6. Specify the Export Options you want used.

Export Options are time-based values. You might find it useful to open the Timeline while setting the 
options.

Start Time specifies the point at which you want to begin exporting. Typically, this is the time when 
objects first appear in the scene.

End Time specifies the point at which you want to stop exporting. This can be any point during the 
scene, up to its end time.

Increment specifies how often you want to take a snapshot of the scene. For example, if a scene is 
30 seconds long, you might save a snapshot at zero seconds and every five seconds thereafter, 
giving you a total of seven snapshot files.

7. Enter a name for the exported file or files in the File Name text box.

Be sure you specify the correct file name extension (.DIB or .WMF). When you export multiple 
snapshots, Action! uses the first five characters from the file name you enter and appends three 
sequential digits and the appropriate file extension. For example, four files from the same scene 
might be named GRAPH001.DIB, GRAPH002.DIB, GRAPH003.DIB, and GRAPH004.DIB.

8. Click OK.





Print Setup command

Use the Print Setup command to specify printing options. When you use this command, the Print Setup 
dialog box appears.

Printer setup options are standard Windows features. 



The options in this dialog box may vary depending on your configuration.



Print command

Use the Print command to print scenes, timeline, and other components from the current presentation.

When you select this command, the Print dialog box appears, allowing you to set the following options:

- Use the Print What drop list to choose what to print.

Select 1, 2, or 4 scenes per page. Action! scales the scenes to fit the page.

- Specify a Print Range.

Select All to print all scenes. Select Current Scene to print only the current scene. To print a specific 
range of scenes, select Scenes and enter values (from 1 to the number of scenes in the 
presentation) in the From and To text boxes.

- Select a Print Time.

- Specify whether or not to print scene backgrounds.

When scenes contain complex backgrounds (such as gradients or images), printing is considerably 
slower. Select Omit Background to suppress printing of the backgrounds and speed up the 
printing process.

Other options in the Print dialog box are standard Windows options.





Print to Video command

Use the Print to Video command to record a copy of the current presentation on videotape. When you 
select this command, Action! automatically sets your monitor screen to full page display, shows the first 
scene of the presentation, and displays the Print To Video dialog box.

First press the Record button on your videotape recorder. Wait at least 4 seconds, then click Print to 
Video in the dialog box. Action! begins outputting your presentation to the videotape. 

Printing to video requires special hardware:

- A video card that can output in the NTSC or PAL video format.

- A video cassette recorder properly connected to your video card.

Tip: If you are using a screen saver (such as After Dark or the Microsoft Windows Screen Saver), turn it 
off before printing to video. If the screen saver activates while you are printing, the image will be 
recorded on your videotape.



Exit command

Use this command to quit Action! If you've made any changes to the presentation since you opened it, 
you will be prompted whether to save those changes.



Edit menu

Click a command for more information:

Related topic: Other commands on the Edit menu



Other commands on the Edit menu

When an OLE object is selected, the Edit menu includes a Do Verb submenu.

When a Chart Data Window is open, the Edit menu changes to include the commands shown below 
(click a command for more information):



Undo and Redo commands

Undo command--Reverses the last operation performed. The command changes to specify exactly 
what operation will be reversed--such as, Undo Typing.

Redo command--Once you apply the Undo command, the menu changes to show    the Redo 
command, which allows you to cancel an Undo (thereby redoing the original operation).



Cut command

Removes the current selection from the scene and places it on the Clipboard.



Copy command

Copies the current selection to the Clipboard. The copied object remains intact in the scene.



Paste command

Paste current contents of Clipboard into the current scene or template.



Paste Link command

Use this command to link a range of cells in the Data Window to a range of cells in a different 
spreadsheet file.

To establish the link, copy the range of cells from the external file into the Clipboard. Switch to Action!, 
select one or more cells in the Data Window, and use the Paste Link command.

You cannot edit the linked cells in the Data Window. Action! updates them automatically whenever the 
data in the original application changes. The link remains active as long as both applications remain 
open. If you exit from either application, you must re-create the link to re-activate it.

This option is only available if the application to which the data is linked supports the standard Windows 
Dynamic Data Exchange (DDE) feature.



Paste Special submenu

The commands on the Paste Special submenu allow you to paste the contents of the Clipboard into the 
application and specify how you would like to paste the contents.

Depending on the contents of the Clipboard, the Paste Special submenu will vary. Click a command 
from the Paste Special submenu for more information:

Bitmap
DIB
Link
Object
OLE object
Palette
Presentation
Slide
Text
Windows Metafile



Paste Special -- Bitmap command

This command pastes the object on the Clipboard in a BMP format. The object does not retain any of its 
timing attributes. 



Paste Special -- DIB command

This command pastes the object on the Clipboard in a DIB format. The object does not retain any of its 
timing attributes. 



Paste Special -- Link command

This command pastes the DDE object on the Clipboard as a linked object. 



Paste Special -- Object command

The Object command provides various options for controlling how objects on the Clipboard can be 
pasted into a scene.

To use the special pasting options:

1. Copy the object or objects to the Clipboard.

2. Move to the scene into which you want to paste the object or objects.

3. Choose Object from the Paste Special submenu on the Edit menu.

The Paste Special dialog box appears.

4. Select a Time option to specify how the object's time attributes should be pasted.

Select From Offset to paste the object with the same time offset from the beginning of the scene as 
the original object. The current position of the playback head in the timeline determines where the 
pasted object starts. For example, if the original object starts at 2 seconds into the scene, the 
pasted object also starts at 2 seconds if the playback head is at zero. However, if the playback 
head is at 3 seconds, the object is pasted starting at 5 seconds--in other words, it is offset 2 
seconds from the playback head position.

Select From Now to disregard the object's offset and paste the object at the current scene time.

5. Select one of the Attributes options to specify which object attributes should be pasted.

Select All to paste all of the original object's attributes, including timing attributes.

Select Static to paste only those attributes that are not affected by time, such as color, fill pattern, 
and Hold option. Time-related attributes, such as transitions, sounds, motion, and link, are not 
pasted.

6. Click OK or Cancel.





Paste Special -- OLE object command

Related topic: Insert OLE command (on the Edit menu)

You can embed information from an existing file of an OLE server application. For example, you might 
want to embed sales information from an existing spreadsheet file.

To embed information from an existing file:

1. Start the OLE server application and open the document that contains the information you want to 
embed.

2. Copy the information from the document to the Windows Clipboard.

3. Start Action! and display the scene where you want to embed the information.

4. Choose Paste Special from the Edit menu, then OLE Object from the Paste Special submenu.

The embedded object appears in the Action! scene.



Paste Special -- Palette command

Select this command to use the palette from the object on the Clipboard as the palette for the current 
scene or template. 



Paste Special -- Presentation command

This command pastes the contents of the Clipboard as a new scene. The Clipboard must contain a 
Windows Metafile. 



Paste Special -- Slide command

This command pastes the metafile on the Clipboard as a new scene. 



Paste Special -- Text command

This command pastes the object on the Clipboard as text. The object does not retain any of its timing 
attributes. 



Paste Special -- Windows Metafile command

This command pastes the object on the Clipboard as a Windows Metafile. The object does not retain 
any of its timing attributes. 



Delete command

Deletes the current object or objects.



Clear command

Use this command to clear the selected cell(s) in the Data Window.



Select All command

Select all objects in the current scene. Locked template objects are not selected.



Duplicate command

Creates a copy of the current selection.

To duplicate the currently selected object or objects, choose Duplicate from the Edit menu.

To duplicate an object into another scene, use the Cut, Copy, Paste, and Paste Special commands on 
the Edit menu. 



Clear Special submenu

Click a command on the Clear Special submenu for more information:



Clear Special -- Dynamic command

Clears an object's time-related options, including Enter, Hold, and Exit options, sounds, interactive links, 
and so forth. Does not affect non-dynamic options such as color and hold duration. Use Undo to 
reverse the command's effect.



Clear Special -- Beginning to Now command

Decreases the object's overall duration. Its start time is set to the current time (the position of the 
playback head in the timeline). Depending on the current time, this command can remove some or all of 
an object's enter, hold, and exit options.

To use this command:

1. Open the timeline and select the object in the timeline or scene window.

2. Drag the playback head to the position where you want the object to start.

3. Choose Beginning to Now from the submenu.



Clear Special -- Now to End command

Decreases the object's overall duration. Its end time is set to the current time (the position of the 
playback head in the timeline).

To use the command, proceed as described above for the Beginning to Now command. However, when 
you choose New to End from the submenu, Action! clears the object's duration from the current 
playback head position to the end of the scene.



Insert OLE command

Related topics: Creating an OLE object
Dragging and dropping OLE objects
Paste Special--OLE Object (on the Edit menu)
Do Verb submenu (on the Edit menu)

Use this command to display a dialog box for inserting an OLE object into a scene or template.

OLE is short for Object Linking and Embedding, a Windows feature that allows you to embed 
information created by one Windows application, into another Windows application. For example, you 
might create a picture in the Windows Paintbrush utility which you want to embed into an Action! 
presentation.

By using OLE to embed an object, you also create a link between the embedded object and the 
application that created the object. For example, even though the paint utility picture resides in an 
Action! scene, the picture is still linked to the paint utility. 

If you decide you want to edit the embedded picture, all you have to do is open the picture object. 
Because the object is linked, Windows starts the paint utility and the program appears on screen 
displaying the object ready to be edited.



Creating an OLE object

To create an OLE object:

1. Choose Insert OLE from the Edit menu.

The Insert OLE object dialog box appears.

2. Select an object type.

Only OLE server applications that can create and embed an OLE object are listed in the dialog box. 

3. Click OK.

Depending upon the level of OLE implementation, either the OLE server application window 
appears or (if the OLE server supports In Place editing) the OLE server replaces the Action! menu 
and tool bar.

4. Using the menus and tools from the OLE server application, create the information you want to 
embed into the Action! scene. 

For example, use the paint utility tools and menus to create a picture. For more information about 
how to use the application refer to its user documentation.

5. Close the OLE server application.

How you close the OLE server application depends upon if the OLE server application window is 
displayed or not (which depends on the version of OLE you are using):

- If the OLE server application is displayed, double-click the close box on the OLE server 
window. Do not double-click the Action! close box unless you want to quit Action!

 You are then asked whether you would like to embed the object to the Action! Presentation. 
Click Yes to close the current application and embed the object.

- If the Action! application is displayed with the OLE server menu and tool bar, choose Return to 
Action! from Action's file menu. Or, click outside of the OLE object.

The embedded object now appears in the Action! scene. 



Dragging and Dropping an OLE object (OLE version 2.0 only)

Many OLE 2.0 server applications support drag and drop features that allow you to select and drag 
information from an OLE server window to the Action! window.

To drag and drop an OLE object:

1. Select the information in the OLE server window.

The cursor changes to a pointer with a box beneath it to show that information is attached.

2. Drag the selected information to the Action! window.

If you cannot embed the information at the cursor's current location, when dragging, the cursor 
changes to a circle with a diagonal line through it.

3. Drop the object by releasing the mouse button over the Action! window.



The list of object types will vary based on the OLE server applications on your computer.



Do Verb submenu

OLE objects use special menu commands which make it easier to edit the objects. These special 
commands are called "Do Verbs" because they perform an action on the OLE object.

Note: The Do Verbs for an OLE object can vary from application to application because of different 
levels of OLE implementation. 

To choose a do verb:

1. Select an OLE object.

2. Choose Do Verbs from the Edit menu, then choose a command from the Do Verb submenu.

You can also position the pointer over an OLE object and click the right mouse button see a list of 
Do Verb menu commands.

3. Using the menus and tools from the OLE server application, create the information you want to 
embed in the Action! scene.

For example, use the Paintbrush utility tools and menus to create a picture. For more information 
about how to use the application, refer to its user documentation.

4. Close the OLE server application.

How you close the OLE server application depends upon if the OLE server application window is 
displayed or not (which depends on the version of OLE you are using):

- If the OLE server window is displayed, double-click the close box on the OLE server window. 
Do not double-click the Action! close box unless you want to quit Action! 

 You are then asked whether you would like to embed the modified object to the Action! 
Presentation. Click Yes to close the current application save the changes the embedded object.

- If the Action! window is displayed with the OLE server menu and tool bar, choose Return to 
Action! from Action's file menu or click outside of the OLE object.

Tip: Double-click an OLE object always performs the first operation in the Do Verb menu. For many 
objects, the first menu item is the Edit command. However, double-clicking on an object can also 
perform other actions. For example, if you double-click on a media clip, it starts to play. 

If an embedded object supports the Play verb, Action! will automatically start the object playing when 
you click the object during a presentation playback.



Edit/Reshape Object command

The name of this command changes in the menu depending on the selected object.

You can use this command to edit any of the following (click for more information):

Arcs
Polygons
Sounds
Digital videos
Metafiles



Reshape Arc command

To reshape an arc:

1. Select the object.

2. Choose Reshape Polygon from the Edit menu.

Action! places reshaping handles at the beginning and end of the arc. 

3. Drag any reshaping handle to change the shape of the object. 

4. When you finish reshaping, click away from the object to deselect it.



Reshape Polygon command

To reshape an arc:

1. Select the object.

2. Choose Reshape Arc from the Edit menu.

Action! places reshaping handles at each point of the polygon.

3. Drag any reshaping handle to change the shape of the object. 

4. When you finish reshaping, click away from the object to deselect it.



Edit Sound command

The Edit Sound dialog box has two variations--one for sound files, the other for audio CD selections.

Use the Edit Sound dialog box to specify the play time for the sound, including its start and end time.

When you use the Edit Sound dialog box to work with a sound file (that is, a WAVE or MIDI file), begin 
by using the Import Sound dialog box to select the file. The name of the file appears in the Sound File 
text box and you can edit the file at that point.

When you use the Edit Sound dialog box to work with a CD audio selection, click the CD Details button 
to access the CD Audio Editor. Use the Start/Track/Time and Stop/Track/Time controls to specify your 
selection.

When you attach a sound to a scene, the only way to select the sound is to use the timeline. When you 
display the timeline, the sound object is represented by an object bar. Click the bar with the right mouse 
button to display the menu, then choose Edit Sound. The Sound Editor dialog box appears. The lower 
portion of the Sound Editor dialog box provides options for controlling sound playback:

- Playback Duration specifies how long the sound should play. The default value is the actual length 
of the sound. If you enter a value that is greater than the current scene length, the sound will 
continue to play into the next scene and beyond.

- Select To End of Scene to play the sound until the end of the scene, without regard to its natural 
length. If the sound is shorter than the current scene length, it plays repeatedly to the end of the 
scene. If it is longer than the current scene length, it will be cut off.

- The time scale shows the current scene length.

- The speaker icon shows where the sound begins to play. The triangle at the end of the line shows 
where the sound ends. Each tick mark along the line indicates one complete cycle of the sound.

Drag the speaker icon to the right to have the sound start playing further into the scene. Drag the 
triangle icon to the left to shorten the playback duration.





Edit Digital Video command

The Digital Video Editor can be used to modify the following movie options for AVI-type movies:

- Punch In and Punch Out Times

- Sound Track Volume

- Playback Speed

Setting Punch In and Punch Out times

When you import a movie file, Action! always imports the entire movie--from beginning to end. If you do 
not want the entire movie to play, you can set a Punch In time (the point in the movie where playback 
starts) and a Punch Out time (where playback ends).

To set a Punch In time:

1. Specify the start time in the Punch In Control text box.

2. Click the Punch In button.

Specify the Punch Out time exactly the same way, but use the Punch Out controls.

Setting sound track volume

If the movie you import contains an audio sound track, Action! plays the sound track at 100% of its 
original volume, by default. 

To adjust the sound track volume, enter a percentage value in the Sound Track Volume text box. For 
example, enter 50 to play the sound track at half it original volume. The maximum value you can enter 
is 100.

Setting movie playback speed

When you import a movie file, Action! always plays the file at 100% of its original recorded speed, by 
default.

To adjust the playback speed, enter a percentage value in the Playback Speed text box. For example, 
enter 50 to play the movie at one-half of its original speed. The maximum value you can enter is 100.





Explode Metafile command

When you import a Windows metafile (.WMF file type extensions), you can "explode" the file into its 
individual components once it is part of an Action! scene.

The original metafile is a single object, as indicated by the single set of selection handles on its 
perimeter. The exploded metafile, on the other hand, has many sets of selection handles, one for each 
individual component comprising the original metafile. 

Once you explode a metafile, you can work with the individual components. For example, you could 
select a btimap graphic component and give it a different color, or move it to a different location.



Object Options command

Use this command to display the Object Options dialog box for the selected object. 

All objects have characteristics, called options. The types of options available depend on the type of 
object. Option groups appear in panels, which look like tab cards. Once the dialog box is open, you can 
change panels by clicking the card's tab. 

An Object Option dialog box will include one or more of the following panels (click for more information):

- Button
- Interactivity
- Motion
- Movie
- Picture
- Sound
- Visual

Shortcut: Another way to display the Object Options dialog box is to use the right mouse button.  If you 
are in Scene or Template view, move the pointer over a the object and press the right mouse button to 
display the Object Options menu. You can also display the Object Options menu in the scene sorter by 
clicking the scene to modify with the right mouse button to display the Scene Options menu.





Button (Object Options dialog box)

In the Button panel, you set the following options for the selected button:

- Select a Button Style on the left side of the options panel.

- Enter Text (if any) to appear on the button.

- Set the Position of the text:

- Top--Above the button
- Center--Centered on the button
- Top--Below the button.





Movie (Object Options dialog box)

In the Movie panel, you set the following options for the selected movie:

- The name of the current movie file appears in the Movie File text box. Action! identifies the type of 
file below the text box. To select a different movie file, click Browse.

- Select Loop to cause the movie to play continuously if the scene length is longer than the movie 
length. The Loop option has no effect if the movie is the same length as or longer than the scene 
length.

- Select Leave Last Frame to leave the final frame of the movie displayed in the scene at the 
movie's end.

If the scene is longer than the movie, the final frame of the movie remains visible until the end of the 
scene; otherwise, the movie object disappears from the scene at the movie's conclusion.

- Select Movie Sound if the movie file contains a sound track that you want played with the movie.

- Select Play Movie Only to play only the movie object. If the scene contains other animated objects, 
Action! suspends their playback while the movie plays. When the movie finishes, the other objects 
resume their motion.





Picture (Object Options dialog box)

Using the options in the Picture panel, you can select a picture for the object. Click the Browse button 
to select a picture file to import into the presentation.





Sound (Object Options dialog box)

This sound is one attached to an object so that it plays in conjunction with the object's appearance in a 
scene. 

In the Sound panel, set the following options for the selected object:

- Select a WAVE, MIDI, or CD audio selection to play. 

When you select CD Audio, the Sound panel provides options for selecting a portion of the audio 
disc to play. Click Edit, and the CD Audio Editor dialog box appears. (When you attach a CD audio 
selection to an object, the correct audio CD must be available in the CD-ROM drive during the 
presentation.)

For WAVE and MIDI, click Browse and the Import dialog box appears. Use the dialog box to locate 
and select the WAVE or MIDI sound file you want. When you return to the Object Options dialog 
box, the file you selected is named in the Sound File text box, the type of sound file is shown below 
the text box. 

- The Playback Options can be used to modify and test the way the sound file plays in conjunction 
with the object. These controls let you specify when the sound starts playing and its duration.

- The Object Scale indicates how long the object appears in the scene. If the object has enter and 
exit options set, vertical lines appear in the scale indicating the length of each option.

- The sound icon shows the point at which the sound begins to play. It also indicates the current 
length of the sound, which is the same as shown in the Play Time text box.

The sound icon can be used to:

- Change the sound's start time relative to the object's start time by dragging the icon left or right. 
Note that when you drag, the Start Time values (described below) update dynamically.

- Adjust the sound's play time by dragging the triangle at the end of the line left or right. When 
you drag, the play time value updates dynamically.

- The Start Time drop-down list provides three options that are the same as the motion options--
enter, hold, and exit. Adjacent to the list is a text box where you can specify an offset value. For 
example, if you choose Hold from the list and enter three seconds in the offset box, the sound 
begins to play three seconds after the object enters its Hold state.

- Click Preview to play the sound file using the current playback options.





CD Audio Editor

The CD Audio Editor gives you access to any portion of an audio compact disc currently in a CD-ROM 
drive. Use the controls in the dialog box to select any portion of the disc for playback.

CD Audio Editor controls make it easy to select entire tracks, portions of one or more tracks, or even the 
entire CD.

- The Start/Track/Time controls indicate the precise location on the disc to begin playing. For 
example, to begin playing at the start of track three, enter 3 in the Track box and 0 (zero) in the 
Time box: or, to begin playing at 10 seconds into track number four, enter 4 as the Track value and 
10 as the Time value.

- The Set button enters the current location into the Track and Time text boxes. Click the Play button 
to listen to the disc, then click Set at any point to indicate the beginning of the selection.

- The End/Track/Time controls and Set button work exactly like the Start controls. They specify the 
location where playback ends.

- To jump to a specific track, enter the number of that track in the Current text box, then click the 
Play button.



Visual (Object Options dialog box)

In the Visual panel, set the following options for the selected object:

- The Left and Top values specify the object's X and Y coordinates on the screen, respectively. The 
values are expressed in screen pixels and correspond to the object's upper left corner. To position 
an object precisely, enter values in the Left and Top text boxes.

- The Width and Height values specify the object's horizontal and vertical dimensions, respectively. 
The values are expressed in screen pixels. To specify an object's dimensions, enter values in the 
Width and Height text boxes.

- Fill displays a color palette for assigning colors to an object.

- Highlight displays a color palette for selecting a background color for patterns. This works in 
conjunction with the Fill option described above and the Fill Pattern option described below.

- Border displays a color palette for assigning a color to the border that surrounds the object. Use 
the Line Weight tool in the tool palette to set the border's width.

- The Shadow option can be used to draw a drop-shadow offset to the lower right side of the object. 
To select a color for the shadow, click the color chip to display the color menu and make your 
selection.

- The Ink Mode drop-down list can be used to apply various ink effects to an object. To apply a 
different ink mode, choose the one you want from the drop-down list.

The default ink mode, Copy, is suitable for most situations. White Transparent is useful when you 
want the background to show through the white area of an object, such as when the object is a non-
rectangular shape. Transparent makes an object non-opaque. Experiment with the various ink 
modes to see what effects you can achieve.

- Fill Pattern displays a palette for assigning a pattern to the object's fill. The drop-down list below 
the palette can be used to select different assortments of pattern palettes.





Motion (Object Options dialog box)

The Motion panel has a complete set of tools for controlling the motion of an object. Included are the 
following options (click underlined text for more information):

- Start Time specifies the time at which the object appears in the scene. Enter a value in the text box 
to set a start time.

- Play Time specifies how long the object stays visible in the scene. The value here is always equal 
to the sum of the enter, hold, and exit values specified to the right (you'll read about these options 
below). To enter a specific play time, enter a value in the Play Time text box.

To have the object remain visible in the scene until the end (no matter how long the scene lasts), 
select To End of Scene. This is the default play time for all objects except sounds and movies, 
which always use their natural play time.

- Enter determines when an object to enters a scene and how long it takes.

- Hold determines how long an object is displayed in a scene.

- Exit determines when an object leaves a scene and how long it takes.

- Use the Timing Bar, located immediately above the Enter, Hold, and Exit options, as an alternate 
way to set the object's timing. When you set values in the option boxes, they are reflected in the 
timing bar. You can also make adjustments to the timing bar by dragging the individual rectangles, 
and by dragging the ends of the timing bar.



Enter options

- In the Enter text box, specify a duration for the enter phase. Action! automatically sets the duration 
of the option to a default of one second--that is, a value of one second appears in the Enter text 
box. To increase or decrease the duration, enter the desired value.

- To have the object enter by moving from the edge of the scene, click the From button and choose 
an option. At the bottom of the list are two special options (click for more information): Start/End and 
Path Editor.

- To have the object perform a special effect when it enters, click the Effect button and choose an 
option from the appropriate submenu.



Using Start/End and Path Editor

These two options in the From pop-up menu provide a way to define object motion that is more complex 
than the standard options in the menu.

Use Start/End to define a straight path for the object to follow between two points. When you use this 
option, you specify the start and end points and Action! creates all of the necessary motion between the 
two.

Use Path Editor to define a path that contains multiple segments and multiple points. When you use this 
option, you specify each point along the path in sequence and the elapsed time between points. Using 
the Path Editor is similar to drawing a polygon.

To use Start/End:

1. Position the object at the point in the scene where you want its path to end.

2. Display the Object Options dialog box for the object and choose Start/End from the From pop-up 
menu.

The scene area of your screen clears and the Path Editor panel appears.

3. Specify the duration time for the path.

Either drag the knob on the slider, or use the buttons to set the time. The time is displayed in the 
dialog box.

4. Drag the object to its start position in the scene.

You can even drag the object off any edge of the scene.

When you release the mouse button, Action! draws a line between the start and end positions for 
the object.

5. Click Done in the Path Editor panel.

You return to the Object Options dialog box.

Using Path Editor is similar to using Start/End, although there are some significant differences:

1. Position the object at the point in the scene where you want its path to end.

2. Display the Object Options dialog box for the object and choose Path Editor from the From pop-up 
menu.

The Path Editor panel appears.

3. Specify a duration time for the first segment of the path.

4. Drag the object to the end position of the first segment.

5. Specify a duration time for the next segment of the path.

6. Drag the object to the end position for that segment.

Repeat the last two steps as many times as necessary to create each segment of the path.

7. Click Done in the Path Editor panel.

Tip: You can edit a start/end or path editor path by repeating the steps described in the preceding 
sections. However, in most cases you'll find it easier to delete the object and start from the beginning 
with a new object.

Note: You can only have one path defined per scene. Every object in the scene that uses the Path 
Editor option must follow the same path.



Exit options

- In the Exit text box, specify a duration for the exit phase. Action! automatically sets the duration of 
the phase to a default of one second--that is, a value of one second appears in the Enter text box. 
To increase or decrease the duration, enter a value.

- To have the object perform a special effect while entering, click the Effect button and choose an 
option from the appropriate submenu. Specify an Effect Time--how long you want the exit effect to 
take.



Hold options 

These control how long the object remains stationary in the scene, and they can also apply a visual 
effect to the object during some or all of that time.

To set object hold options:

1. To specify exactly how long the object should remain stationary, enter a value in the Hold text box.

2. To apply a hold effect to the object, display the Effect pop-up menu and choose an option.

The best way to learn about these effects is to experiment.

(When you choose a Sparkle hold effect, a color chip appears next to the Effect pop-up menu.)

3. Display the color menu by clicking the color chip next to the Effect menu and choose a color for the 
effect.

4. If desired, specify a duration for the effect in the Effect Time text box.

When you select an effect, Action! automatically sets the Effect Time value equal to the hold value. 
To increase or decrease the duration of the effect, change the value in the text box.

5. When you finish selecting all options in the Object Options dialog box, click OK.

To set other object options, click the appropriate option tab.



Interactivity (Object Options dialog box)

Interactivity options cause a specific event to occur when someone clicks an object while the 
presentation is playing. Action! does provide a standard set of buttons from which you can choose, but it 
also lets you make any object interactive.

In the Interactivity panel, select the following options for the selected object:

- To cause the object to highlight when clicked, check the Highlight option. Action! highlights most 
objects by swapping their fill and highlight colors.

- To perform an action when the object is clicked, click Action and select an action to perform from 
the drop-down list. 

Pause/Continue--Pauses the scene. To resume, press the spacebar on your keyboard or click the 
right mouse button.

Stop--Stops the presentation.

Go to Next Scene, Go to Previous Scene, Go to First Scene, Go to Start of This Scene--Sends 
the presentation to the specified scene. Action! remembers the point of origin. The Return option 
(see below) can then be used to return to the point of origin.

Go to Link--Sends the presentation to a scene not specified by the preceding options. When using 
Go to Link, you must select the destination scene in the Destination Scene drop-down list. The list 
shows all scenes in the presentation. To enter the Destination Scene at some point other than the 
beginning, enter a value in the Offset Time text box. For example, enter 3 to start three seconds into 
the destination scene.

Return--Returns the presentation to the point from which the most recent "Go To" was issued.

Skip to Next Scene, Skip to Previous Scene, Skip to First Scene, Skip to Start of This Scene--
Each of these options sends the presentation to the specified scene. This is distinctly different from 
the Go To options because Action! does not remember the point of origin.

Skip to Link--Use to send the presentation to a scene not specified by the preceding options. 
When using Skip to Link, you must specify the Destination Scene in the drop-down list. Select the 
destination scene in the Destination Scene drop-down list. The list shows all scenes in the 
presentation. To enter the Destination Scene at some point other than the beginning, enter a value 
in the Offset Time text box. For example, enter 3 to start at the three second mark in the destination 
scene.





Locked to Template command

Locks the selected objects in the template so that they cannot be changed or moved by users.

When you lock a template object, that object cannot be changed in any way once the template is 
applied to a scene. It is important to lock those objects you do not want template users to change. It is 
equally important not to lock the objects that users do need to change.

A check mark appears next to the command when the selected object is locked.

When you apply a template to a scene, objects you can edit have a double-line frame around them. You 
can edit these objects in any way--change text object content, cut, copy, and paste objects, resize and 
move objects, and so forth.

Once you modify a template object in any way, Action! replaces the double-line frame with standard 
selection handles.



Preferences command

Use this command to open the Preferences dialog box.

Once you specify your preferences, Action! enforces them until you make a change.

You can set the following preferences (click for more information)

- Select your preferred Stage Size. Stage size does not affect the size of Action! windows. It 
determines the size of the area in which the presentation actually plays. If you are creating a 
presentation on a large monitor screen (such as a 19-inch), but it will be played on a smaller 
screen, set the Width and Height values for the target monitor. The default dimensions (Width=640, 
Height=480) are standard size for most VGA monitors. This setting affects new presentations only, 
not a currently opened presentation.

- Select your preferred Grid Size. The grid is an invisible matrix of points within your work area that 
you can use to align objects. 

To change the spacing between grid points, enter values in the Width and/or Height text boxes. 
Values are in pixels.

- Specify your preferences for the Control Panel.

The Rew/FF options control what happens when you click the rewind and fast forward buttons on 
the control panel.

Select Directly to Start/End to move the playback head directly to the start or end of the current 
scene.

Select Multiplier and enter a value to control the speed of the playback head. (To rewind and fast 
forward at 3 times the normal playing speed, enter 3.)

The Timestep value controls the increments (in tenths of second) in which the playback head 
moves when you click the backstep and step buttons. For example, if you enter 10, the playback 
head moves in one second increments.

- Minimum Duration specifies the default duration for new scenes with no objects.

- Select a default font to use in outline view. The current font selection is shown in the dialog box. To 
select a different font, click Change to display the standard Font dialog box and choose the font you 
want. 





Clear command

Use this command to clear the selected cell(s) in the Data Window.



Insert Row and Insert Column commands

To insert a new row into the Data Window:

1. Select the row below where you want to insert the new row.

2. Choose Insert Row from the Edit menu.

A new blank row appears above the selected one. 

To insert a new column in the Data Window: 

1. Select the column to the left of where you want to insert the new column.

2. Choose Insert Column from the Edit menu.

The new column appears to the left of the selected one.



Delete Row and Delete Column commands

To delete a row or column: 

1. Select the row or column you want to delete.

2. Choose Delete Row or Delete Column from the Edit menu.



Go To Cell command

Use this command to select a specific cell in the Data Window.



Number Format command

Use this command to set the number format for a specific cell in the Data Window.



View menu

Click a command for more information:



Differences between the scene sorter and outline views

Feature Scene sorter Outliner

Duplicate scenes Yes No
Cut, Copy, Paste scenes Yes No
Delete scenes Yes Yes
Reorder scenes Yes Yes



Scene view

You can switch to scene view by clicking the scene view icon (the top icon above the vertical scroll bar, 
on the right side of the Action! window), or by selecting an option from the Scene submenu on the View 
menu.

In scene view, you can see how text and other objects appear in a scene.

Scene submenu of the View menu

Click part of the Scene submenu for more information:

Most Action! presentations contain multiple scenes. A scene is similar to one you might see in a movie 
or a play--it can contain scenery (an Action! template or background) and actors (Action! objects such 
as a picture, drawing, or text). 



Scenes listed in the Scene submenu

Click a name of a scene in the submenu to view that scene (in scene view).



Scene Browser command

Displays a dialog box for browsing through the available scenes so that you can select a scene to 
display.

When you choose this command, the View Scene dialog box appears listing the scenes in the 
presentation. 

1. Select a scene from the list and a thumbnail picture of the scene appears. 

2. Click OK to display the scene.

Note: You can also display thumbnail pictures of scenes using the scene sorter. This has the advantage 
of displaying all the scenes in a presentation at the same time, and allows you to rearrange the order of 
the scenes. 



New command (Scene submenu)

Select this command to insert a new scene after the currently viewed scene.



Outline view

You can switch to outline view by clicking the outline view icon (the second icon from the top above the 
vertical scroll bar, on the right side of the Action! window), or by selecting the Outline command on the 
View menu.

In outline view, you can use the outliner, a tool for creating and organizing the text content of a 
presentation. The outliner provides many of the functions found in the outlining component of a word 
processing program.

The outliner works in conjunction with scene view--that is, when you change the text in outline view, 
Action! automatically makes the same change to the scene in scene view; likewise, when you change 
text in scene view, Action! immediately reflects that change in outline view.

Note: Outline view provides limited functionality compared to Scene view. The functions you can 
perform pertain to text processing--that is, entering text, editing text, checking spelling, and so forth.

Related topics:

About the outline view window
Working with Text in outline view
Working with Scenes in outline view
Using Templates in outline view
Differences between the Scene Sorter and outline views



About the outline view window

The Outline view window shows information for every scene in the presentation. The window consists 
of three separate columns:

- Scene Information--shows the current scene number as an ordinal value. 

- Text--displays the text present in each scene of the presentation. This is a work area where you 
can enter and edit text.

Outline View Tool Bar

The tool bar in Outline view provides a few quick access functions. You can also access all of these 
functions and many others via the menus.



Using Templates in outline view

You can use templates in outline view for entering text. You can select a template library when creating 
the presentation, and you can also load a template at any subsequent point. For example, you might 
decide to apply a different bullet list template while working in a scene. When you switch back to scene 
view, you'll see the template applied to the scene.

Note: Applying a different template library to an existing presentation in outline view is subject to the 
same rules and conditions as in scene and scene sorter views. 

To load a template library to use:

1. Choose Load Template Library from the File menu.

2. Use the dialog box to select the library you want.

If you make changes to the templates in a library and want to save them, you can make a new template 
library:

1. Choose Make Template Library from the File menu.

2. Use the dialog box to name and save the current template library under a different name and 
description.

Applying templates to scenes

To apply a template from the current library to a scene, select the scene or scenes to which to apply the 
template.

To select a single scene, click anywhere in the text column to insert the cursor in one of the scene's 
paragraphs. To select multiple scene, drag the cursor in any column to highlight at least one paragraph 
in each scene.

Select a template from the template selector drop list in the tool bar. You can also select from the Use 
Template submenu in the Scene menu.

Remember, applying a different template to a scene can affect the scene's content. 



Working with Text in Outline view

Entering text in Outline view is quite similar to using a word processing application.

1. If necessary, click to insert the text cursor in the line where you want to type.

2. Type the text for the paragraph. At the end:

- Press Return to start a new paragraph.

- Press Shift+Return to continue the same paragraph on the next line.

Action! uses a default font for all text in outline view. You can specify a different default font using the 
Preferences dialog box. You cannot apply font attributes to selected text. The default font applies to all 
text in outline view.

Promoting and demoting text

Organizing information in an Action! outline normally involves establishing levels for each paragraph. 
Information that is subordinate to other information occupies a lower level. For visual clarity, each level 
is normally indented under its superior level.

Setting text levels, promoting and demoting text, and many other outline view operations are essentially 
the same as working with text objects. 

Checking spelling

Outline view provides a spelling checker. This feature is not available in any other view. Remember, 
however, that you can easily switch to outline view at any time to perform a spell check.

To check spelling, choose Check Spelling from the Text menu.

Setting the default outliner font

To change the default font used in the outliner view:

1. Choose Preferences from the Edit menu.

The Preferences dialog box appears.

2. Select a font to use in outline view.

The current selection of font is shown in the dialog box. To select a different font, click Change to 
display the standard Font dialog box and choose the font you want. 



Working with scenes in outline view

Reordering scenes

You can use the outliner to reorder the scenes in a presentation.

1. Position the pointer over the scene marker.

The pointer changes to a crosshair pointer.

2. Drag the scene marker up or down to reposition the scene in a new order within the presentation.

Deleting a scene

To delete a scene in the outliner:

1. Click in the text of any scene you want to delete.

2. Choose Delete from the Scene menu.



Scene sorter view

You can switch to scene sorter view by clicking the scene sorter icon (the third icon from the top above 
the vertical scroll bar, on the right side of the Action! window), or by selecting the Scene Sorter 
command on the View menu.

The scene sorter view is designed for working with multiple scenes. The scene sorter gives you a very 
useful overview perspective of an entire presentation.

The window shows a thumbnail view of each scene in the presentation sorted to the current order. You 
can freely drag the thumbnails to different locations to change the current scene order.

Below each thumbnail is the scene number, scene title, and the name of the template (if any) assigned 
to the scene. Action! highlights this information for the currently selected scene or scenes.

Related topics:

Differences between the scene sorter and outline views
Working with scenes in scene sorter view
Selecting scenes in the scene sorter
Changing scene order in the scene sorter



Selecting scenes in the scene sorter

When you switch to the scene sorter, Action! selects and highlights the scene you were viewing at the 
time.

- To select a single scene, click its thumbnail.

- To select multiple scenes, hold down the Shift key while clicking each thumbnail, or drag a 
rectangle around the ones you want to select. You can also use the Select All command from the 
Edit menu to select all scenes in the presentation.

Options you select subsequently apply to all selected scenes.

- To deselect all scenes, click the empty area of the window.

- To deselect a scene from a selection, hold down the Shift key and click the scene thumbnail.

When you work in scene view, choose the scene you want from the scene selector drop-down list in the 
tool bar.



Changing scene order in scene sorter view

To rearrange scenes into a different sequence:

1. Select the scene or scenes you want to move.

2. Drag the selection to the desired location, then release the mouse button.



Working with scenes in scene sorter view

Duplicating scenes

To duplicate the currently selected scene(s), choose Duplicate from the Edit menu. Action! places a 
copy of each selected scene immediately after the selection.

Cutting, copying, and pasting scenes

The Edit menu provides the standard Cut, Copy, and Paste commands for moving scenes to and from 
the Clipboard.

- Cut removes the selected scenes from the presentation and places them on the Clipboard.

- Copy places a duplicate of the selected scenes on the Clipboard, leaving the originals in the 
presentation.

- Paste Scene inserts the scenes on the Clipboard before the first selected scene or at the end of the 
presentation if none are selected.

Deleting scenes

To delete currently selected scenes, choose Delete from the Edit menu or press the Delete key. 

You cannot delete all the scenes in a presentation. Each presentation must have at least one scene.

If you try to delete a scene to which another scene or an object in another scene is linked, a dialog box 
appears. It identifies the scenes that are linked and the one you want to delete.



Template view

You can switch to template view by clicking the template icon (the fourth icon from the top above the 
vertical scroll bar, on the right side of the Action! window), or by selecting the Template command on the 
View menu.

In template view, you can edit and create your own template designs. Templates let you quickly create 
reuse predefined effects throughout different scenes and presentations.

Template submenu (View menu)

Click part of the Template submenu for more information:

Any and all work you perform on templates must be done in template view. Because templates are so 
similar to scenes, template view is quite similar to scene view. However, template view does provide 
special tools and commands for creating and modifying templates and template families.

Template view icon

The most direct way to switch to template view is to click the template view icon located just above the 
vertical scroll bar.

Depending on the status of the current scene, any of the following events might occur when you click 
the icon:

- If the current scene has a template applied, Action! displays that template in your window when you 
switch to template view.

- If the current scene does not have a template applied, but a template library has been loaded for 
the presentation, Action! gives you the option of switching to the first template in the library.

- If the current scene does not have a template applied and there is no template library loaded for the 
presentation, Action! gives you the option of creating a new template. If you choose this option, you 
switch to template view with a blank template in the window.

When you work in template view, Action! draws a special border inside your window work space.

Also note that Action! replaces the Scene menu with the Template menu.

To exit from template view, click the scene view icon.



Templates listed in the Template submenu

Click a name of a template in the submenu to view that scene (in template view).



Template Browser command (Template submenu of View menu)

Displays a dialog box for browsing through the available templates. You can select a template display 
(in Template view).

When you select this command, the View Template dialog box appears listing the templates in the 
presentation. 

1. Select a template from the list and a thumbnail picture of the template appears. 

2. Click OK to display the template.



Current command (Template submenu of View menu)

Switch to template view and display the template applied to the current scene.



New command (Template submenu of View menu)

Creates a new (blank) template scene. If you are not already in template view, Action! automatically 
switches to template view.



Span Time command

Action! has two time modes to make editing and viewing a scene easier: span-time mode and point-in-
time mode. 

In span-time mode, all the objects in the scene become visible, regardless of the playback head 
position. Use span-time mode to view all the objects in a scene, including all the text placeholders. 

You might also use span-time mode to initially place objects in a scene because all the objects in the 
scene are visible. 



Point in Time command

Action! has two time modes to make editing and viewing a scene easier: span-time mode and point-in-
time mode. 

Point-in-time mode displays the current scene as it appears at the playback head position. 

In point-in-time mode the scene appears at a point in time, where scene objects may or may not be 
visible depending upon when they are scheduled to appear in the scene. When you play a presentation, 
Action! automatically switches to point-in-time mode.



Scene menu

Click a menu command for more information:

The Scene menu provides commands that are equivalent to many of the controls found in the Control 
Panel.

Related topics: Scene menu keyboard shortcuts



Scene menu keyboard shortcuts

The Scene menu lists the equivalent keyboard controls for the commands it contains. However, 
additional keyboard controls are also available. The following table lists all keyboard controls in the 
Scene menu.

Function=Keys    (Notes)

Play Presentation=Ctrl+Enter    (Hides all menus, palettes, windows, and other components. Plays 
presentation in full screen mode from the beginning.)

Stop=Ctrl+Shift+S or Esc    (Stops playback head and returns screen to previous state.)

Rewind=Ctrl+Shift+R    (Rewinds presentation according to selection in Preferences dialog.)

Backstep=Ctrl+Shift+<    (Moves playback head backward according to selection in Preferences 
dialog.)

Step=Ctrl+Shift+>    (Moves playback head forward according to selection in Preferences dialog.)

Play=Ctrl+Shift+P    (Plays current scene starting from current position of playback head.

Fast Forward=Ctrl+Shift+F    (Jumps ahead in presentation according to selection in Preferences 
dialog.)

Pause=Enter or Left Mouse Button    (Puts presentation in pause state. Press Spacebar or click 
Right Mouse Button to resume.)

While playing a presentation, use the Page Up and Page Down buttons to move to the next or previous 
scene.



New command

Creates a new scene immediately following the current one. The new scene is blank and it initially uses 
the same template as the current scene when the command is invoked.



Insert command

This command inserts one or more scenes into the current presentation at the location you select and, if 
desired, using a specific template. When you choose this command, the Insert Scene dialog box 
appears. 

- Enter the number of scenes to insert in the text box, or accept the default of one.

- Indicate where to insert the scene or scenes. You can always insert a scene at the Beginning or at 
the End of the presentation. 

In scene sorter view, After Selection is available only when you select a scene prior to choosing 
the command. It inserts the scene following the selection.

In scene view, there is an After Current Scene option.

- Select a template to use from the Using Template list, or select No Template. A thumbnail of the 
selected template appears in the Template Preview Window. The list is empty if a template library 
has not been opened.

By default, new scenes are named Scene #1, Scene #2, and so on. After you add a title to a scene, that 
title becomes the name of the scene. 

You can also insert a scene by clicking the new scene icon in the tool bar, or by choosing New from the 
Scene menu. Either action inserts a single scene following the currently selected scene, using the 
currently selected template. 





Delete command

Deletes the current scene from the presentation.



Use Template submenu

Click a part of the Use Template submenu for more information:

Templates are grouped together into template libraries. When you pick a template library, you are 
picking a design shared by all the templates. After you pick a template library, a preferred template from 
the library is applied to the first scene. After the first scene appears, you can quickly apply another 
template from the same library to the scene if you don't want to use the preferred template.

Related topic: About template libraries



About template libraries

Template libraries all contain the same set of templates and are interchangeable. For example, each 
library has a conclusion template; however the design of the template is different. By having the same 
set of templates, you can quickly change the design of a presentation by selecting and applying another 
Action! template library. Action! automatically finds and replaces each scene in a template with the new 
template design.

If you add objects to a scene, then change templates, you need to be aware of the following conditions. 
After you apply a different template to a scene, Action! compares the names of the objects in the current 
scene to those in the template being applied. The following conditions can result:

When changing templates with additional objects, and . . .

. . . the new template contains an object for which there is no matching object name in the 
current scene, Action! copies the template object to the scene, and identifies it as having come 
from the template.

. . . a template object has the same name as one already in the scene, the scene object is 
replaced. If the scene object being replaced originated from a template, Action! applies the 
necessary object options from the new template to the new object while retaining the original 
content.

. . . an object has no corresponding object in the new template, Action! deletes the object if the 
object originated from the previous template that was applied to the scene.



Templates listed in the Use Template submenu

If you selected an Action! template library, the library contains a list of different templates you can apply 
to a scene. For example, if you don't like the preferred template that has been applied to the first scene, 
you can choose another template. 

In addition, as you add new scenes to a presentation, you might want to apply different templates to the 
new scenes. All the templates are designed for specific purposes. Some templates are designed to 
introduce a presentation, while others are better used for the content of a presentation. The name of 
each template in a template library gives you a clue as to what the template was designed for.



Template Browser command (Use Template submenu)

The template browser allows you view a thumbnail picture of a template before applying it to a scene.

To use the template browser:

1. Choose Browser from the Use Template submenu.

The Use Template dialog box appears with a list of the templates in the current library. 

2. Select the template you want to apply.

A thumbnail picture of the template appears in the Preview Window.

3. Click OK to apply the selected template to the current scene. 



No Template command (Use Template submenu)

Choose No Template to remove the template (and all template material) from the current scene.



Background command

Set a background for the current scene.

Note: When you specify a gradient fill for a scene's background, Action! creates a special color palette 
containing the colors necessary to create a smooth blending of the gradient colors. 



Options command

Choose this command to display the Scene Options dialog box, in which you see the following options 
(click underlined text for more information):

- Scene name. The name you enter here appears wherever scenes are listed in Action!

- Background: allows you to change the background of a scene. For example, you might want to 
use a blue gradient background, import a picture, and so on.

- Time: lets you set the length of a scene and how long the scene plays during a presentation.

- Color: lets you select a color palette for a scene. 

- Template: allows you to change the template that is currently being applied to the scene. 

- Transition: lets you set a visual effect to take place when a scene begin and ends.

Shortcut: Another way to display the Scene Options dialog box is to use the right mouse button. If you 
are in scene view, move the pointer over a the scene (not over an object) and press the right mouse 
button to display the Scene Options menu. You can also display the Scene Options menu in the scene 
sorter by clicking the scene to modify with the right mouse button to display the Scene Options menu. (If 
you select multiple scenes in scene sorter view, your option changes apply to all of those selected.)



Background (Scene Options dialog box)

Setting the background option

The Scene Options dialog box gives you five options for selecting a background.

- Use Template applies the current template background to the scene. Use this option to restore the 
template background if you have made a different selection.

- Pattern applies foreground and background colors to the scene along with a fill pattern.

- Gradient applies a graduated color series to the scene's background.

- Picture lets you select an image for the background.

- Same as applies the same background as an existing scene in the presentation to the current 
scene. The Scene Background dialog box appears when you click the button.

Tip: If you use a picture as the background for a scene and want to use the same picture for 
another scene, use the Same as option for maximum efficiency. Large pictures require 
significant space on disk and in memory. When you use the Same as option, the picture loads 
only once. If you import the picture separately into each scene, you needlessly store multiple 
copies of the picture.



Time (Scene Options dialog box)

Time options set the scene's length and also specify its playback speed.

To specify a specific scene length, select the Scene Length Option button and enter a time value in 
the text box.

To have Action! automatically extend the scene length to the end point of the last object in the scene, 
select As Long as Objects.

Playing Time adjusts the speed of the playback. (The Playing Time and Scale text boxes are 
connected. You cannot change one without changing the other.) If the Scene Length is set to 10 
seconds and the Playing Time is set to 5 seconds (or 50%), the playback head moves at twice the 
original speed. Likewise, if the Playing Time is set to 20 seconds (200%), the playback head moves at 
half speed.



Color (Scene Options dialog box)

Use this option to select a color palette to use for the scene. The drop-down list contains the names of 
all palettes currently used in the presentation.

Note: Changing the color palette of an existing scene can change the appearance of the existing 
objects in the presentation.



Template (Scene Options dialog box)

Setting the Template options

Use this option to choose and apply a template to the selected scene(s).

Before you can apply or change a scene template, you must open the template library containing the 
template you want. Use the Load Template Library command in the File menu to select and open a 
template library.

Note: Applying a new template to a scene can result in the loss of objects if the template does not 
properly accommodate the scene.



Transition (Scene Options dialog box)

The options on the Transition panel apply a transition to the scene (a visual effect that takes place when 
the scene starts) and also specifies what should happen at the end of the scene.

When you apply an In Transition to a scene, Action! displays an icon to the left of the thumbnail in the 
scene sorter and also in the status bar. The icon represents the selected transition effect. In addition, 
when you select an At End of Scene option, Action! displays that information to the right of the scene's 
thumbnail in the scene sorter, as well as in the status bar.



Play command

Plays the current scene or template starting at the beginning.



Stop command

Stops the playback head in the scene or template.



Step Forward command

Moves the playback head forward in the scene in small time increments.



Step Backward command

Moves the playback head backward in the scene in small time increments.



Fast Forward command

Jumps directly to the end of the current scene--that is, moves the playback head in the timeline to the 
end of the scene.



Rewind command

Rewinds the current scene to its beginning.



Add Loop command

Use this command to insert loop markers in the scene. The playback head moves continuously 
between the loop markers when the scene plays.

A Loop repeats a specified time segment of a scene. You create a loop by specifying a start and end 
time. During playback, the scene loops back to the start time when it reaches the end time. The scene 
remains in a loop indefinitely, so you must provide some means of exiting. Scenes can contain as many 
different loops as needed. 

Loop controls appear in the time scale wherever a loop is set in the scene. You can create, remove, and 
edit loops directly in the time scale.

To create a loop:

1. Hold down the Shift and Ctrl keys and click in the time scale where you want to insert the loop.

Two loop controls appear in the timeline. 

2. Set the loop duration by dragging the loop controls away from one another.

The loop won't work if you don't separate the loop controls.

Another way to insert a loop is choose Add Loop from the Scene menu and enter the Start Time and 
End Time in the Add Loop dialog box.

To remove a loop, drag either loop marker up or down out of the timeline.

To edit a loop:

Drag the loop control in the time scale, or:

1. Double-click either of the loop controls.

The Edit Loop dialog box appears.

2. Enter the Start Time and End Time for the loop.

You can remove the loop by clicking Delete.

If you insert a loop in a scene, you must provide a way to exit from that loop. For example, you 
might create a button that appears while the loop is in progress. When the button is clicked, Action! 
could present another part of the scene or presentation.



Add Pause command

Inserts a pause marker in the scene. The playback head pauses when it encounters the marker. Type a 
numeric or alphabetic key to continue.

A Pause stops the scene at a specified time. The scene remains paused until some other action causes 
it to resume. A scene can contain as many different pauses as needed. 

A pause control appears in the time scale at each location where a pause occurs in the scene (except 
for those pauses specified in a text object's bullet motion). You can create, remove, and edit pauses 
directly in the time scale.

To create a pause:

1. Hold down the Ctrl key and click in the time scale where the pause is to occur.

A pause control appears at the location you click. 

2. If necessary, drag the pause control to another time.

Another way to insert a pause is to choose Add Pause from the Scene menu. When the Add Pause 
dialog box appears, enter the time where the pause is to occur.

To remove a pause:

Drag the pause control up or down out of the timeline.

To edit a pause:

Drag the pause control in the time scale, or:

1. Double-click the pause control in the time scale.

The Edit Pause dialog box appears. 

2. Enter the time for the pause to occur. 

To remove the pause, click Delete.

Note: Action! displays a special pause cursor when the playback head reaches a pause in the scene. 
Press the Spacebar on your keyboard or click the right mouse button to resume playing the scene.



Set Preview Time command

Specifies the current scene (at its current time) as the thumbnail that appears in dialog box preview 
windows.



Add Title Text command

This command applies only in Template view. 



Add Body Text command

This command applies only in Template view. 



Template menu

Click a menu command for more information:

You create and edit templates in the same way you create and edit scenes. You can place any type of 
object in a template, and you can set object options as needed.

Remember, a template and a scene are basically the same components except that you can lock 
objects in a template.

Related topic: About template libraries



New command (Template menu)

Creates a new, blank template immediately following the current one.



Insert command (Template menu)

This command applies only to scenes, not templates, so it is not available in template view.



Delete command (Template menu)

Deletes the current template from the presentation.



Use Template submenu (Template menu)

This command is available only in the Scene menu, when in a view other than template view.



Background command (Template menu)

Set a background for the current template.

Templates, like scenes, can have backgrounds--such as patterns, gradients, pictures, and so forth. 
However, if you apply a background option to a scene, it overrides the template's background.

When you specify a gradient fill for a scene's background, Action! creates a special color palette 
containing the colors necessary to create a smooth blending of the gradient colors. 



Options command (Template menu)

Choose this command to display the Template Options dialog box, in which you select the following 
options (click underlined text for more information):

- Template name. This name appears in lists of templates throughout Action! 

- Background: allows you to change the background of a template. For example, you might want to 
use a blue gradient background, import a picture, and so on.

- Time: lets you set the length of a template and how long the template plays during a presentation.

- Color: lets you select a color palette for a template. 

- Transition: lets you set a visual effect to take place when a scene begins or ends.

Shortcut: Another way to display the Template Options dialog box is to use the right mouse button: 
move the pointer into the template background (not over an object) and press the right mouse button. 
Then choose Template Options from the menu. 



Background (Template Options dialog box)

The Template Options dialog box gives you five options for selecting a background.

- Pattern applies foreground and background colors to the template along with a fill pattern.

- Gradient applies a graduated color series to the template's background.

- Picture lets you select an image for the background.

- Same as applies to the current template the background from another template in the presentation. 
The Template Background dialog box appears when you click the button.

Tip: If you use a picture as the background for a template and want to use the same picture for 
another template, use the "Same as" option for maximum efficiency. Large pictures require 
significant space on disk and in memory. When you use the "Same as" option, the picture loads 
only once. If you import the picture separately into each template, you needlessly store multiple 
copies of the picture.



Time (Template Options dialog box)

Time options set the template's length and also specify its playback speed.

To specify a particular template length, select the Template Length Option button and enter a time 
value in the text box.

To have Action! automatically extend the template length to the end point of the last object in the 
template, select As Long as Objects.



Color (Template Options dialog box)

Use this option to select a color palette to use for the template. The drop-down list contains the names 
of all palettes currently used in the presentation.

Note: Changing the color palette of an existing template can change the appearance of the existing 
objects in the presentation.



Transition (Template Options dialog box)

You can apply any one of a number visual effects that takes place when a scene using this template 
starts. Click the Effect button and select an effect from the pop-up lists. You can control the length of 
the effect, by entering a Duration time (in seconds).



Play command (Template menu)

Plays the current scene or template starting at the beginning.



Stop command (Template menu)

Stops the playback head in the template.



Step Forward command (Template menu)

Moves the playback head forward in the template in small time increments.



Step Backward command (Template menu)

Moves the playback head backward in the template in small time increments.



Fast Forward command (Template menu)

Jumps directly to the end of the current template--that is, moves the playback head in the timeline to the 
end of the template.



Rewind command (Template menu)

Rewinds the current template to its beginning.



Add Loop command (Template menu)

This command only applies to scenes (under the Scene menu in scene view).



Add Pause command (Template menu)

This command only applies to scenes (under the Scene menu in scene view).



Set Preview Time command (Template menu)

This command only applies to scenes (under the Scene menu in scene view).



Add/Make Title Text command (Template menu)

Adds a title text object to the template.

The name of this command changes to Make Title Text when a text object is selected. Use this 
command to make the selected text the title text.



Add/Make Body Text command (Template menu)

Adds a body text object to the template.

The name of this command changes to Make Body Text when a text object is selected. Use this 
command to make the selected text the body text.



Arrange menu

Click a menu command for more information:

The way in which you arrange objects in a scene can be very important. The Arrange menu provides 
commands for arranging objects.



Align command

Aligns two or more objects relative to each other. Available only when two or more objects selected. 
Aligning objects relative to one another gives a scene an organized appearance. Action! provides many 
different options for object alignment.

When you use this command the Align Objects dialog box appears. Select the alignment method you 
want to apply to the selected objects, then click OK. You can also double-click the alignment option you 
want.





Sequence command

Synchronize two or more selected objects so that their appearance in the scene is relative to the other 
objects.

Sequencing objects lets you control when they appear in a scene relative to one another. For example, 
you might want a series of ten objects to appear exactly one second following the appearance of each 
preceding object. You can accomplish this manually in the Timeline window, but the Sequence 
command provides a simpler and more efficient method.

The order in which you select objects can be important to the resulting sequence.

When you use this command the Sequence Objects dialog box appears. Set the options of the dialog 
box:

- Enter a value in the Start Each Object text box to stagger objects by a specific amount of time.

- Select one of the After Previous Object options to specify, for each object, when it should begin to 
appear relative to the previous object.

- Select one of the Ordering the Objects options to specify the order in which objects should be 
sequenced.

- Select From back to front to sequence objects based on the scene layer in which they reside. 

- Select In the order they were selected to sequence objects based on the order you selected 
them in the scene.





Bring To Front command

Moves the selected object or objects directly to the front layer of the scene. 

Note: Movie objects always occupy the front layer of any scene.



Send To Back command

Moves the selected object or objects directly to the back layer of the scene.

Note: Movie objects always occupy the front layer of any scene.



Bring Forward command

Moves the selected object or objects one layer toward the front of the scene.

Note: Movie objects always occupy the front layer of any scene.



Send Backward command

Moves the selected object or objects one layer toward the back of the scene.

Note: Movie objects always occupy the front layer of any scene.



Group command

Forms all currently selected objects. Grouped objects can be processed as a single object.

Grouping provides a way to arrange two or more objects so that you can handle them as though they 
were a single object.

After you group the object, selection handles (small black boxes) appear on the perimeter of the group. 

Operations you perform on a group affect all objects in the group. For example, if a selected group 
contains six rectangles and you choose a color from the tool palette, Action! applies the color attribute 
to all rectangles in the group. Similarly, if you resize the group, each rectangle is changed 
proportionally.

Action! automatically changes the order of the layers in the group (if necessary) so that all objects 
occupy contiguous layers. The group occupies the same layer as the front most object--other objects in 
the group move to subsequent layers.

Note: You can use the Select All command on the Edit menu to select all objects in a scene or 
template.



Ungroup command

Restores objects in a group to their original, individual states. The command is available only when a 
grouped object is selected.

You can, at any time, return any or all objects in a group to their individual states. However, if you 
change the objects while they are grouped, they do not revert to their original attributes.



Snap To Grid command

Activate/Deactivate the grid snap feature. When active, objects snap to the nearest grid point when 
created or moved.

This is a toggle-type command. Choose the command again to deactivate the grid. When the grid is 
active, a check mark appears to the left of the command in the menu.

Action! also provides an invisible drawing grid to help align objects. The grid consists of a matrix of 
points in the scene window. When you draw, move, or resize an object while the grid is active, it 
automatically snaps to the nearest grid point. 

You can specify spacing between grid points using the Preferences command in the Edit menu.



Text menu

Click a command for more information:

Related topic: Using text in scene/template view vs. outline view



Using text in scene/template view vs. outline view

You can replace text of scenes in scene view or outline view. Each has their own tools.

Scene/Template Outline
Feature View View

View all text in a scene Yes* Yes
Add and edit text Yes Yes
Change text style Yes No
Align text Yes No
Change text font size Yes No
Add text border Yes No
Apply templates Yes Yes
Change levels of paragraphs Yes Yes
Use spell checker No Yes

* Span Time mode

After you become comfortable with outliner and scene view, you might find yourself switching back and 
forth between them to work with text. 



Face submenu

Use the Face submenu to select a typeface for the selected text. If no text is selected, use the Face 
submenu to set the typeface used as a default for new text.

The typefaces listed in the submenu will reflect those installed on your computer.

Choose the More command to select a typeface not listed on the submenu.



Size submenu

Select a type size for the selected text. If no text is selected, use the Size submenu to set the type size 
used as a default for new text.

More--Displays the Font dialog box for specifying a font size that does not appear in the Size submenu.
Smaller--Decreases the current text selection to the next available font point size.
Larger--Increases the current text selection to the next available font point size.



Style submenu

Select a type style for the selected text. If no text is selected, use the Style submenu to set the type 
style used as a default for new text.

Plain--Applies plain style to selected text. Removes such attributes as boldface and italic, which may be 
currently applied to the text object.
Bold--Applies the boldface attribute to selected text.
Italic--Applies the italic attribute to selected text.
Underline--Applies the underline attribute to selected text.

Bulleted--Turns bullet feature on and off for a line of selected text. A check mark next to the command 
indicates the feature is on and a bullet appears in the text line; otherwise, the feature is off.



Font command

Displays the Font dialog box for selecting a font and font attributes to use.





Level submenu

Use commands on this submenu to set the level of the selected paragraph(s).

You can set the paragraph(s) to a specific level or use the Promote and Demote commands:
- Promote--Moves the selected paragraph(s) one level higher in the outline structure. 

- Demote--Moves the selected paragraph(s) one level lower in the outline structure. 

Text objects have an outline-type structure. Each line in a text object is assigned a level within the 
structure. Levels are important because they permit each level to function in its own unique way. 

Lines at level two are subordinate to those at level one: lines at level three are subordinate to those at 
level two: and so forth. A subordinate line is indented (or, demoted) beneath the line which is one level 
higher. You can easily demote and promote lines to whatever level you require. 

Text objects can consist of one or more lines of text. When typing a text object, press Enter at the end 
of a line to start a new line.



Motion Gallery command

Selects and applies a standard set of text and bullet motions to selected text. Can also be used to 
create a custom set of motions.

Action! contains a built-in set of pre-defined motions that you can quickly and easily apply to text 
objects. You can also create your own customized motions.

This command brings up the Text Motion Gallery dialog box, which contains the following settings:

- Select an option from the Text motion list. 

Action! previews your selection in the preview window.

To create a custom set of actions from scratch, scroll to the bottom of the list and click Custom. 
When customizing motions, you work in the Text Options dialog box. 

- To adjust the speed of the motion, drag the motion speed slider. Click your selection in the Motion 
Slider list again to preview it with the new speed applied.

- Select Pause After Each Bullet to pause the scene immediately after each bullet item enters. 
When Action! invokes the pause, the pause cursor appears. Press the spacebar to resume after the 
pause.





Bullets command

Displays the Bullet panel of the Text Options dialog box. Use to specify bullet options such as style, 
font, color, and so forth.

Related topic: Text Options command.



Text Options command

Displays the Text Options dialog box for the selected text object. Options are grouped into the following 
categories in the dialog box (click for more information):

- Bullet

- Text Motion

- Bullet Motion

The Text Options dialog box lets you control the motion of a text object and apply special effects to the 
text. In addition, this dialog box allows you to set the format of bullets and control the motion of bulleted 
text.

Important: The concept of levels is very important when defining paragraphs. You can define different 
options for each level of text, apply the same options to all levels of text, or any other combination you 
want.

To apply text options, select a line in the text object that is at the level you want to define. For example, 
if you want to define text options for level 1 paragraphs only, select a level 1 line in the text object.

When the Text Options dialog box appears, it indicates the level you selected. To make your changes in 
the dialog box apply to all paragraph levels, select All Levels.



Text motion options

The Text Motion panel of the Text Options dialog box lets you specify the following options, which affect 
individual paragraphs (they do not affect the text object as a whole):

- Set the Enter, Hold, and Exit properties.

- If desired, set a relative time delay for text lines. The time delay specifies an amount of time that 
elapses between text lines entering the scene at the selected level. For example, you can specify 
that each subsequent Level 1 text line should enter the scene five seconds after the previous one 
reaches its Hold state: or specify that it enters one second after the previous text line exits from the 
scene.

- To set a time delay, choose Enter, Hold, or Exit from the Start Next Paragraph At drop-down 
list, then enter a time in the text box immediately below.

- You can also set the delay time by dragging the time delay icon to the appropriate position on 
the timing bar.

- To create a pause in the scene following a text line, select Pause. When the pause occurs, 
Action! displays the pause cursor, prompting the user to resume the presentation by pressing 
the spacebar on the computer keyboard or clicking the right mouse button.

- To have the text fade to a different color, select the Fade to option, then select a color from the 
color chip. Color fades when the next bullet at the same (or higher) level enters.



Text bullet options

The Bullet panel of the Text Options dialog box specifies options for the bullets of a selected paragraph:

- Select Show Bullets to have a bullet appear with the paragraph. Deselect this option to prevent the 
bullet from appearing. The other options in the panel are then disabled.

- Select a bullet style from the Style drop-down list.

- Select the font to use for the bullet from the Font drop-down list. Action!, by default, uses the same 
font as assigned to the text. 

- Select a character to use as the bullet from the Character drop-down list. Depending on the font 
you select, the bullet character might be displayed differently from that shown in the text box. Check 
the preview window to see exactly how the bullet is displayed.

- To increase or decrease the size of the bullet character relative to the text size, enter a percentage 
value in the Size box.

- To make the bullet character appear in the same color as the text, select Same as Text. To display 
the bullet in a different color, select the button next to the color chip and select the color you want.



Bullet motion options

The Bullet Motion panel of the Text Options dialog box provides options that specify how a bullet 
character moves in conjunction with the text line to which it is attached.

To specify bullet effects:

- Set the Bullet action separate from text option. If this option is deselected, the bullet character 
functions in the same way as the text with which it is associated, so all other options are disabled.

- Select the Bullet Entry options you want. 

- Select Before Text to have the bullet character enter the scene before the text does. 

- Select With Text to have the bullet enter at the same time as the text. 

- Select After Text to have the bullet enter after the text.

To apply motion and effects to the bullet as it enters, click the From or Effect button and choose 
from the pop-up menus.

- Select the Bullet Exit options you want.









Alignment submenu

Select a text alignment for the selected text. If no text is selected, use the Alignment submenu to set the 
alignment used as a default for new text.

Left--Aligns selected text with the left margin.
Center--Aligns the current text selection midway between the left and right margins.
Right--Aligns the selected text with the right margin.



Border submenu

Select a line width for the border of the selected text. If no text is selected, use the Border submenu to 
set the border line width used as a default for new text.



Text Ruler command

Use this command to activate and deactivate the text ruler feature. When active, the text ruler appears 
when adding new text objects or editing existing ones.

Related topic: Text ruler



Text Ruler 

Use the tools at the top of the text ruler to format the selected text.

Click a part of the text ruler for more information:



Tabs and margin markers

Tabs

You can select any one of three different tab alignment options. From left to right, the tab icons 
represent left, center, and right alignment. Tab stops apply to the entire text object--that is, they affect all 
paragraphs at all levels. Tab stops are useful in creating tables.

To insert a tab:

1. Select the type of tab stop you want--left, center, or right aligned.

2. Click in the marker area at the location you want the tab placed.

A tab symbol appears in the marker area.

To change a tab stop's location:

- Drag the tab symbol left or right in the marker area.

To remove a tab stop:

- Drag the tab symbol up or down out of the marker area.

Margin markers

You can drag the margin markers to affect the selected paragraphs.



Alignment and spacing tools

The text alignment tools, from left to right, align selected text to the left, center, and right boundaries of 
the text ruler.

- Line spacing tools increase and decrease the spacing (or, leading) after lines within a paragraph.

- Paragraph spacing tools increase and decrease spacing after paragraphs.

These tools affect only the selected paragraph or paragraphs.



Bullet marker

The bullet marker indicates the position of the bullet (if any) for the selected text line. The space 
between the bullet marker and the next text margin marker defines the space between the bullet 
character and the first character of the text line. Note that the bullet on/off tool in the tool bar must be 
depressed for bullets to show.

Drag the marker left or right to change the bullet position. Note that you cannot remove the bullet 
marker.

Changes to the bullet marker affect the current paragraph and all other paragraphs assigned to the 
same level. This is also true for the text margin markers.



Check Spelling command

Use this command to check spelling of words in text objects. This command is available only in outline 
view. 

 When you choose the Check Spelling from the Text menu, the Check Spelling dialog box appears and 
Action! immediately begins the spell check from the beginning of the presentation.

When Action! detects a potential spelling error, it:

- Displays the word in the Not in dictionary text box.

- Displays a list of possible corrections in the Suggestions list.

- Displays the most likely correction in the Change to text box.

To replace the misspelled word with:

- The one Action! suggests, click Change.

- One of the other words in the Suggestions list, click the word in the list, then click Change.

- Any other word, type it in the Change to text box, then click Change or double-click the word in the 
list. (Action! checks the spelling of your word before continuing.)

Action! replaces the misspelled word and continues with the spell check.

If you do not want to change the word:

- Click Ignore to leave only this one occurrence as is.

- Click Ignore All to leave all occurrences of the word unchanged.

When finished, the Close button changes to a Done button. Click the Done button to return to the 
outliner





Chart menu

Click a menu command for more information:

Charts are a compact and informative way to show trends and important points when using data in a 
presentation. There are four types of charts you can create in Action!: bar, line, area, and pie charts. 

Related topics: Different chart types
Chart tool



Different Chart Types

Chart
Type Best Used for...

Bar Comparing similar types of figures. For example, comparing north, south, east, west regional 
sales figures for each quarter.

Line Plotting a figure against two values. For example, the price of single stock over a period of 
time.

Area Plotting and comparing similar types of figures against two values. For example, the price of 
several stocks over a period of time.

Pie Showing the relative size of a contribution. For example, showing the relative size of each 
department in a company.



Basic chart terms

There are two values basic to most types of charts:

- A series: a set of values for one item at different places on the X-axis. 

- A category: a set of values measured at one location on the X-axis. 

When creating a chart, you can add motion to a series and category of a chart. For example, you can 
add motion to the years and the commodities to determine when and how they appear in the chart.

Bar, line, and area chart terms

Bar, line, and area charts are also called X-Y charts because they display data along X (horizontal) and 
Y (vertical) axes. Action! uses X-Y terminology to help you visualize where different elements appear on 
the chart. 

Note: You can control which chart elements you want to appear in a chart, including: the various chart 
labels, grid markings, legend, and range of values.

Pie chart terms

Pie charts represent one category of data as slices of a pie. The following figure identifies the main 
components of a pie chart. 

Note: Pie charts show only the relative contribution of the part to the whole pie; they do not plot a point 
relative to other values as with X-Y charts.



Gallery command

Select this command to open or close the Chart Gallery window for the selected chart. You select a 
chart type and style from the this window. Action! provides four basic types of charts. Each chart type 
provides variations on styles. 

Action! automatically opens the Chart Gallery when you create a new chart. 

- Choose a chart type from the Type drop-down list. You can choose Bar Charts, Pie Charts, Line 
Charts, or Area Charts. Each type has a variety of styles, which are shown by the icons at the top of 
the Chart Gallery.

- Click the icon for the Chart Style you want.

- Click Plot to plot the chart using the selected chart type and style. 

If you aren't satisfied with the chart, repeat the steps in this section to apply a different Chart Type and 
Style.

Note: Some Chart Types are not suitable for some types of data. In many cases, if you choose an 
unsuitable Chart Type for the current data range, Action! warns you and does not plot the data. 
However, in some cases Action! cannot make this determination and will attempt to plot the data 
anyway. The resulting chart might not make sense for the current data range.



Data Window command

Related topics: Displaying the data window
Navigating in the data window
Selecting cells in the data window
Assigning uses to data window cells
Adding and editing data

Use this command to hide or display the Data Window, where you do the following:

- Enter and edit chart data.

- Specify which data to include in a chart.

- Define chart elements such as axis titles, series names, and category names. 

You can type data directly into the Data Window, or import data from some other source, such as a 
spreadsheet application.

Note: Displaying the Data Window changes the content of the Edit menu.

When you first create a chart, the Data Window includes sample data. You will want to replace this data 
with your own data. 



Displaying the data window

The rows and columns in the Data Window form a grid of cells, just like a spreadsheet. Each cell 
contains one element of chart information, either:

- A data value, which tells Action! the information that needs to be plotted in the chart.

- Chart text, which defines the text that appears for the different chart titles, such as the X-axis title or 
the Y-axis title.

The following appear in the Data Window:

- Column letters appear in the horizontal gray bar just above the columns. 

- Row numbers appear in the vertical gray bar to the left of the columns. 

- The column letter and row number of the active cell appear in the cell address box. 

- The cell edit box shows the contents of the active cell.

Note: In the sample data, you can immediately begin replacing the value in each cell because each has 
already been defined for a specific purpose. However, if you add additional cell information, or move 
cells around, you'll need to define the purpose of the values in the cells again. 



Navigating in the data window

Cursor Key Movements

This key Moves the Cursor

Up arrow Up
Down arrow Down
Left arrow To the left
Right arrow To the right
Home To the beginning of the row
End To the end of the row
Pg Dn To the bottom of the column
Pg Up To the top of the column

To move to a part of the Data Window that is off the screen, use the arrow keys or the horizontal and 
vertical scroll bars on the edge of the Data Window. 

To move to a specific cell, choose Go To Cell from the Edit menu and enter the column letter and row 
number of the cell in the dialog box.



Selecting cells in the Data Window

When you move the pointer over table cells, the cursor changes to a special cross-shaped Data 
Window cursor. You use this cursor to select cells in several ways, as shown in the following table.

To Select Do This

An individual cell Click the cell.

A column Click the letter at the top of the column.

A row Click the number to the left of the row.

A group of adjoining cells Click the cell in one corner of the group, drag to the opposite corner, 
release the mouse button.

A specific cell Choose Go to Cell from the Edit menu and enter the cell column letter 
and row number in the dialog box.

After you select a cell, the contents appear in the Cell Edit box. If more than one cell is selected, only 
the contents of upper-left cell in the selection appear.

You can also use the chart items drop-down list at the top of the Data Window to select text elements or 
the data range. To select these items:

1. Choose the item from the drop-down list. 

2. Click Show in the Data Window.

The cell for that item becomes the currently active cell and appears in the cell edit box, where you 
can edit the contents. 



Assigning uses to Data Window cells

When working with information in a Data Window, you must:

- Enter (or replace) the information in the Data Window.

- Tell Action! what type of information is contained in each cell.

There are five different types of data cells in the Data Window. Each type of data cell is assigned a 
function using the chart item drop-down list. 

For example, the data range is the set of data from which Action! plots the chart. If you add a column of 
numbers to the Data Window, the numbers do not automatically become a part of the data range until 
you specifically tell Action! which cells to plot in the chart. 

You can assign any use to a cell or cells using the chart items drop-down list, the Set button, and the 
Show button.

To see which type of information is in a cell or cells:

1. Select the item you want from the drop-down list.

2. Click Show.

For axis titles, the cell address and content appear in the cell address and cell edit boxes. For the 
data range, series names, and category names, Action! highlights the cells.

To change the data range:

1. Select the cells to include in the data range.

Action! plots only the data cells in the data range.

You can select the first (or, upper left) cell, then Shift-click the last (or, lower right) cell. Or, drag 
across the cells you want to select.

2. Choose Data Range from the chart items drop-down list.

3. Click Set.

The selected cells now compose the new data range.

Note: To change the data range quickly and easily, select the desired cells and click Plot. Action! plots 
the chart using the selected cells, and those cells become the new data range.

To change the cells for series names, category names, or axis titles:

1. Select the cells for the new names or title.

2. Choose the chart item you want from the drop-down list.

3. Click Set.

To plot a chart with the new settings:

- Click Plot.

Data Window changes do not take effect until you click Plot.



Adding and editing data 

There are several ways to add and edit information to the Data Window. These different methods are 
discussed in the following sections. 

Note: Remember, if you add information outside of the default chart information, you might have to re-
assign the uses for the data in each cell. Refer to the previous section for more information on how to 
assign a use to a cell.

Editing data directly in the data window

To edit data directly in the Data Window: 

1. Select the cell you want to edit.

2. Edit the data in the cell edit box.

You can use standard editing methods such as deleting and typing in the edit box, and using Cut, 
Copy, Clear, and Paste from the Edit menu.

3. Record the data in the selected cell.

To record (or, enter) the data, press Tab or Enter, or click to select a different cell.

Use the Enter and Tab keys for entering strings of data. Press Enter to select the next cell in the 
current column. Press Tab to select the select in the same row and in the next column to the right. 

4. Continue selecting cells and entering or editing data until finished, then click Plot.

Copying data from other applications using the Clipboard

Use the Clipboard to copy data from other applications into the Data Window.

To copy data from another application:

1. While working in the other application, copy the data to the Clipboard. 

In most cases, you select the data and choose Copy from the Edit menu. However, this can vary 
from one application to another. Check the application's documentation for specific instructions.

2. Switch to or start your Action! software.

If Action! is running, use the Windows Alt+Tab keystrokes to switch to the application. Otherwise, 
start Action! as described earlier in this manual.

3. Open the Data Window and select the cell or cells into which to copy the data from the Clipboard.

4. Choose Paste from the Edit menu.

Action! pastes the data from the Clipboard into the selected cell or cells.

Depending on the format of the data on the Clipboard, it might fill several different cells even if you 
select only one cell in the Data Window.

Plotting updated data

After making changes in the Data Window, you must plot the changes to have them appear in the chart. 
To plot the changes:

1. Reset the data range, if necessary. 

Action! plots only those cells in the current data range.

2. Click Plot.



Data Motion submenu

Click a command for more information:

You can assign motion, interactivity, sound, and visual options to charts. You assign these Options in 
the same way you assign them to other objects. 

Charts can have options that other objects do not. For example, you can apply individual motion to the 
different bars in a bar chart, or to the individual slices in a pie chart. This is an excellent way to 
emphasize data by having it enter and leave in sequence, show trends by building charts piece-by-
piece, and so forth.

When you apply options to a chart using the Object Options dialog box, the options apply to the chart as 
a whole.

When you want to apply options to individual objects in a chart, you use a special series of dialog boxes 
which you access from the Data Motion submenu on the Chart menu.

For X-Y charts, you can apply action to a series or a category--you cannot apply both at the same time. 
For pie charts, you can apply motion only to a series. 



Series command (Data Motion)

Use to apply motion options to the series items in a selected chart object. When you use this command, 
The Data Motion dialog box appears, allowing you to set the following options:

- From the drop-down list, choose the series that you want to work with. 

Choose All Series to assign all settings selected in this dialog box to each and every series. To 
assign the selections to an individual series, select the one you want from the list.

- Click the Enter, Hold, or Exit tab to select an option.

The hold options in the Data Motion dialog box are different than in other options dialog boxes:

- Choose a series or category from the Series list. Choose All Series to assign all settings 
selected in this dialog box to each and every series. To assign the selections to an individual 
series, select it from the list. (Note that when you work with an individual series, the Pause 
When Each Series Has Entered option is not available.)

- Specify a hold duration. 

Select Duration to specify the exact length of time the series or category remains on stage in 
the hold phase, then specify the duration by entering it in the text box. If all series appear on 
stage together at some point, Duration sets how long all groups are on the stage together. If the 
objects are never on the stage together, as when one series always exits before the next series 
enters, Duration sets how long each series or category is on the stage. 

Select Hold until chart ends to have all objects remain on stage for the entire duration of the 
chart.

- Select any pause options you want to use.

Select Pause When All Series Have Entered to place the presentation in the pause state once 
all series have been displayed in the chart.

Select Pause When Each Data Object Has Entered to insert a pause following each object's 
appearance on stage.

Select Pause When Each Series Has Entered to insert a pause following the appearance of 
each series in the chart. Note that this option is available only when you select All Series in the 
drop-down list at the top of the dialog box.

Note: When you select a pause option, Action! displays the pause cursor and stops the 
playback head. To resume the presentation, press the spacebar or click the right mouse button.



Category command (Data Motion)

Use to apply motion options to the category items in a selected chart object. When you use this 
command, The Data Motion dialog box appears, allowing you to set the following options:

- From the drop-down list, choose the category that you want to work with. 

Choose All Categories to assign all settings selected in this dialog box to each and every 
category. To assign the selections to an individual category, select the one you want from the list.

- Click the enter, hold, or exit tab to select an option.

The Hold options in the Data Motion dialog box are different than in other options dialog boxes:

- Specify a hold duration. 

Select Duration to specify the exact length of time the series or category remains on stage in 
the hold phase, then specify the duration by entering it in the text box. If all series or categories 
appear on stage together at some point, Duration sets how long all groups are on the stage 
together. If the objects are never on the stage together, as when one series always exits before 
the next series enters, Duration sets how long each series or category is on the stage. 

Select Hold until chart ends to have all objects remain on stage for the entire duration of the 
chart.

- Select any pause options you want to use.

Select Pause When All Series Have Entered to place the presentation in the pause state once 
all series have been displayed in the chart.

Select Pause When Each Data Object Has Entered to insert a pause following each object's 
appearance on stage.

Select Pause When Each Series Has Entered to insert a pause following the appearance of 
each series in the chart. Note that this option is available only when you select All Categories in 
the drop-down list at the top of the dialog box.

Note: When you select a pause option, Action! displays the pause cursor and stops the 
playback head. To resume the presentation, press the keyboard spacebar or click the Right 
mouse button.



None command (Data Motion)

Turns off all data motion options for the current chart.



Chart Options command

Use this command to choose options for a chart object, including orientation, whether or not to show 
data values, marker style, and so forth. When you select the Chart Options command, the Chart 
Options dialog box appears. The dialog box provides a slightly different set of options for bar, line, and 
area charts than for pie charts:

- To display the data values in the chart, select Show Data Values. In bar charts, Action! displays 
data values above the bars. This option is not available if you choose one of the 3D chart styles. If 
you select Show Data Values, you can also choose a format from the Data Value Format drop-down 
list.

- If you are working with a pie chart, specify whether or not to Show Data Labels and, if shown, 
where they should appear.

- Select a Chart Orientation. Use this option to turn bar, line, and area charts horizontally or 
vertically. The direction for data object motion remains the same when the chart is turned. This 
option is not available for pie charts.

- Select a Data Layout for the chart.

- If working with a line chart, select a marker style. The marker style determines the type of symbol 
used for data markers. From the left drop-down list, choose the series to which you want to give 
markers. From the right drop-down list, choose the marker type for that series.

You can set many chart attributes using the Chart Options, Axis Options, and Perspective commands 
on the Chart menu. Other attributes can be set using the Font menu commands, tool bar icons, and the 
tool palette. 



Axis Options command

You can set the data format, scale, and grid style for the X and Y axes in a chart. The Axis Options 
dialog box:

- Choose X-Axis Attributes or Y-Axis Attributes from the drop-down list at the top of the dialog box. 
The other settings you make in the dialog box will affect the selected axis.

- Specify whether or not to Show Axis Labels.

If you show axis labels for the Y-axis, you can choose a Data Format from the drop-down list.

- For Y-Axis Attributes, select whether to display the Axis Scale as Linear (evenly weighted) or 
Logarithmic (exponentially weighted).

- Select options for displaying tick marks.

Choose the type of tick marks from the drop-down list.

- Choose Major Tick Marks to indicate larger intervals.

- Choose Minor Tick Marks to show smaller intervals between major tick marks.

Select Show Tick Marks to display the tick marks you have selected.

Select Inside, Outside, or Crossing to indicate where you want tick marks displayed--inside, 
outside, or across the axis.

- Select Show Major Grid to display the grid for major tick marks.

The grid is not available for minor tick marks. For 2D charts, you can turn on the X and Y axis grids 
independently. For 3D charts, Show Major Grid displays a grid on the chart floor or walls.

- Select Show Axis Title to display the axis title on the chart.



Perspective command

Available only when the current chart object is a 3D style. Use to select from various view angles and 
also to zoom in and out on the chart objects.

When you select this command, the Perspective Views dialog box appears:

- Select the view option you want by clicking its image icon in the dialog box. A black line surrounds 
the current perspective selection.

- To include walls behind the chart, select Show Left Wall or Show Right Wall.

- To enlarge or shrink a 3D bar chart, choose a setting from the Zoom drop-down list.

- Zoom In enlarges the data objects by the factor shown.

- Zoom Out shrinks the data objects by the factor shown. The zoom resizes the data objects 
only, it does not resize the whole chart.



Window menu

Click a Window menu command for more information:

You can show or hide the Action! tools or palettes to give yourself more space. To show or hide a tool or 
palette, choose the corresponding command from the window menu. 

Action! remembers these settings. The next time you start a session with Action!, the palettes reappear 
as you left them.

A checkmark next to a command means that the tool or palette is currently displayed. Choosing the 
menu command toggles the checkmark and hides or shows the selected tool or palette.



Tool palette

Click a palette button for more information:

The tool palette contains drawing tools that let you draw lines, circles, squares, and so on. It also 
contains a variety of special tools that let you add text, pictures, sounds, movies, and so on to a scene 
in a presentation. 

Related topics: Constraining drawings
Assigning drawing attributes



Constraining drawings

Holding down the Shift key while drawing and object constrains its shape, as follows:

- Rectangles and rounded rectangles constrain to squares.

- Lines constrain to horizontal, vertical, or 45-degree angles.

- Ovals constrain to circles.

- Arcs constrain to 90-degrees.

- Polygon sides constrain to horizontal, vertical, or 45-degree angles.



Assigning drawing attributes

When you draw an object, Action! uses the current default attributes.

To set the current default attributes:

1. Deselect all objects.

2. In the tool palette, select the attributes you want to set.

Attributes may also be set for individual objects without affecting the current default attributes.

To assign attributes to an existing drawn object:

1. Use the selection tool to select the object to change.

Remember, to select multiple objects hold down the Shift key while selecting, or drag a rectangle 
around the objects.

2. In the tool palette, select the attribute or attributes to assign to the selection.



Selection tool

Use the selection tool for the following (click for more information)

Selecting objects
Resizing objects
Positioning objects



To select an object in scene or template view

Click the selection tool (the arrow) in the tool palette.

- To select a single object, click the object.

- To select multiple objects, drag a rectangle around them or hold down the Shift key while clicking 
each object.

Action! displays handles around the perimeter of a selected object.

- To select all objects in the scene or template, choose Select All from the Edit menu.

To deselect an object, click on the background (where there is no object). To deselect a particular object 
when many are selected, shift-click it.

Note: In Scene view, if you cannot select one or more objects, they are template objects that have been 
locked to the template. 



Resizing objects

Objects can be resized after they have been imported into a scene. 

To resize an object:

1. Click the selection tool in the tool palette.

2. Select the object to resize.

3. Drag any one of the sizing handles until the object is the size you want, then release the mouse 
button.

Hold down the Shift key while dragging to constraint the object's proportions while resizing it.

To resize a movie:

1. Click the selection tool in the tool palette.

2. Select the movie object.

Action! places sizing handles around the perimeter of a selected object.

3. Drag any one of the sizing handles until the movie is the desired size, then release the mouse 
button.

Hold down the Shift key while dragging to constrain the movie's proportions while resizing it.

You can increase the size of a movie file after importing it, but doing so normally distorts the movie and 
gives it a grainy appearance. The more you increase the size, the more the distortion. You can achieve 
better results by editing the movie size with the application that created it, if possible.

Note: FLC and FLI movies cannot be resized. Repositioning the sizing handles only changes the 
amount of the movie shown.



Positioning objects

You can freely position objects wherever you want in a scene simply by dragging them. For more 
precise positioning:

- Activate the Snap to Grid feature, or

- Specify the location with the Visual options.



Text tool

Related topic: Text menu

Use the text tool to create or edit text in scene and template view.

To edit text in a scene:

1. Select the text tool in the tool palette and click on any text in the scene.

You can also double-click on any text to display the text tool.

2. Select any text and begin typing. 

The text wraps within the text area if it exceeds the current margins.

3. Type the next line of text:

- To make the line subordinate to the preceding line, press Tab before typing.

- To make the line occupy the same level as the preceding line, do not press Tab.

To make the new line occupy a higher level, press Shift+Tab or Backspace before typing.

Use the text tool if there is no existing text to replace or to create scene text objects in addition to the 
template text objects.



Rectangle tool

Use this tool to create rectangles in scenes and templates.

To create a rectangle:

1. In the tool palette, select the rectangle tool.

Tip: Normally, when you finish a drawing, Action! automatically reselects the selection tool. If you 
want to create several different rectangles, Shift-click the rectangle tools to make it "sticky."

2. Move the cursor inside the scene or template window.

The cursor appears as a cross-hair.

3. Drag to define the opposite corners of the rectangle.    Press the Shift key while dragging to create a 
square instead of a rectangle.



Polygon tool

Use this tool to create polygons in scenes and templates.

To create a polygon:

1. In the tool palette, select the polygon tool.

Tip: Normally, when you finish a drawing, Action! automatically reselects the selection tool. If you 
want to create several different drawings with the same tool, Shift-click the polygon tool to make it 
"sticky."

2. Move the cursor inside the scene or template window.

The cursor appears as a cross-hair.

3. Click to set the first point of the polygon.

4. Click to set the next point. Repeat for each point on the polygon perimeter. 

5. When you reach the final point, double-click to finish.

Action! draws only closed polygons. If you do not connect the last point with the first one, Action! 
automatically connects them with a straight line.



Rounded rectangle tool

Use this tool to create rounded rectangles in scenes and templates.

To create a rounded rectangle:

1. In the tool palette, select the rounded rectangle tool.

Tip: Normally, when you finish a drawing, Action! automatically reselects the selection tool. If you 
want to create several different rounded rectangles, Shift-click the rounded rectangle tool to make it 
"sticky."

2. Move the cursor inside the scene or template window.

The cursor appears as a cross-hair.

3. Drag a rectangle that defines the opposite corners of the rounded rectangle. Press the Shift key 
while dragging to create a rounded square instead of a rounded rectangle.



Ellipse tool

Use this tool to create ellipses and circles in scenes and templates.

To create an ellipse: 

1. In the tool palette, select the ellipse tool.

Tip: Normally, when you finish a drawing, Action! automatically reselects the selection tool. If you 
want to create several different ellipses, Shift-click the ellipse tool to make it "sticky."

2. Move the cursor inside the scene or template window.

The cursor appears as a cross-hair.

3. Drag a rectangle that defines the opposite corners of the circle or ellipse rectangle. Press the Shift 
key while dragging to create a perfect circle instead of an ellipse.



Line tool

Use this tool to create lines in scenes and templates.

To create a line:

1. In the tool palette, select the line tool.

Tip: Normally, when you finish a drawing, Action! automatically reselects the selection tool. If you 
want to create several different circles, shift-click the line tool to make it "sticky."

2. Move the cursor inside the scene or template window.

The cursor appears as a cross-hair.

3. Drag a rectangle that defines the two ends of the line. 



Arc tool

Use this tool to create arcs in scenes and templates.

To create an arc:

1. In the tool palette, select the arc tool.

Tip: Normally, when you finish a drawing, Action! automatically reselects the selection tool. If you 
want to create several different arcs, Shift-click the arc tool to make it "sticky."

2. Move the cursor inside the scene or template window.

The cursor appears as a cross-hair.

3. Drag a line that defines the two ends of the arc. Press the Shift key while dragging to draw an arc of 
a circle instead of an arc of an oval.



Chart tool

Related topic: Chart menu

Use the chart tool to do either of the following (click for more information):

- To create a new chart.

- To select individual object in a chart.

To select a chart object as a whole, click the chart with the selection tool. You can then click the chart 
with the right mouse button to display the Object Options pop-up menu and choose chart options to 
modify. You can also select a different color and fill pattern for the chart background, different line 
weights for the object border, and whatever line color you want.

To deselect the chart tool, click outside the chart box or on another tool in the tool palette. 

Tip: To quickly switch to the chart selection cursor, double-click the chart object with the selection tool.



Creating a new chart

1. Select the chart tool in the tool palette. 

Move the pointer to the presentation window, and it changes to the cross hair cursor.

2. Drag a rectangle in the presentation window for the chart.

The rectangle specifies the chart's original size. You don't have to be precise--you can easily adjust 
the size whenever you want.

When you release the mouse button, Action! displays the Chart Gallery, a sample chart, and the 
Data Window.



Selecting individual objects in a chart

Related topic: Working with chart objects

To select the individual objects in a chart (such as the legend, bars in a bar chart, axis titles, and so 
forth), use the chart tool. When you select the chart tool and move the cursor into the presentation 
window, the cursor changes to the chart selection cursor whenever it is inside the boundaries of the 
chart. However, if you move the cursor outside the chart's boundaries, it becomes a cross-hair and can 
be used only to create a new chart object.

To select an object in the chart, click it with the chart selection cursor. To select multiple objects, hold 
down the Shift key while selecting.

Action! highlights each selected chart object. However, the highlight varies depending on whether or not 
an object is moveable. Moveable objects are highlighted with sizing handles on the object's perimeter. 
You can drag the object to a different location, and you can also change its size by dragging one of the 
sizing handles. Action! highlights immovable objects with a solid border.

Tip: To select an entire series, click the box for the series in the legend.

The standard Action! color, font, and type editing methods are available for the selected components. 



Working with chart objects

To resize the legend:

1. Select the object.

2. Click a handle and drag to resize the box.

Action! automatically rescales the text inside the legend box.

To move the legend or axis titles:

1. Select the item you want to move.

2. Click inside the item and drag it to the new location.

To change colors:

1. Select the items to change.

2. Use the color chip on the tool palette to select a color. 

To change text in axis titles, series names, or column names:

1. Select the text to change.

2. Use the Text menu.

To change the content of axis titles, series names, or category names:

- Edit the cell that contains the element in the Data Window.

Tip: To include titles, subtitles, notes, or footnotes that clarify the chart, use text objects placed over the 
chart.



Button tool

Action! provides a set of button objects in the tool palette; buttons are easily recognizable as being 
interactive. Thus, when a viewer sees an arrow button, they know to click the button to move to the next 
scene in the presentation.

To change other options for an existing button, bring up the Object Options dialog box, and adjust the 
following settings:

- Use the Button panel to select a different button style, change the button's text label, or change the 
position of the button label.

- Use the Motion panel to specify animation options for the button.

- Use the Interactivity panel to change the button's action, highlight option, and interactive sound.

- Use the Sound panel to attach a sound to the button object.

- Use the Visual panel to specify the button's location and size, ink mode, colors, shadow, and 
pattern.



Color chip (tool palette)

Use this tool to select a color for the selected object(s).

When you click and hold the color chip, a color palette appears. To select a color, drag to the right, 
position the cursor over the desired color, and release the mouse button.



Line weight (tool palette)

When you click and hold on the line or border weight tool, a menu appears from which you select the 
line style you want. At the bottom of the menu is the selection More. Select this option to display the 
Line Style dialog box:

Use this dialog box to select a line style and also set the line width (in pixels).

You cannot set the line width for a non-solid line style.



Import picture (tool palette)

Clicking this tool has the same effect as selecting the Import Picture command from the File menu.

Related topic: Import Picture (File menu)



Import movie (tool palette)

Clicking this tool has the same effect as selecting the Import Movie command from the File menu.

Related topic: Import Movie (File menu)



Import sound (tool palette)

Clicking this tool has the same effect as selecting the Import Sound command from the File menu.

Related topic: Import Sound (File menu)



Video overlay (tool palette)

Clicking this tool has the same effect as selecting the Import Video Overlay command from the File 
menu.

Related topic: Import Video Overlay (File menu)



Motion palette

Click a palette button for more information:

The Motion Palette is a handy tool for quickly applying motion to simple objects in a scene, like 
rectangles, lines, and pictures. However, it does not have all the tools and effects of the Object Options 
dialog box.

In addition to setting the motion timing, you can specify direction and special effects you want to occur 
when the object enters, holds, and exits a scene. For example, you can specify that an object enter 
from the upper left corner of the screen, move to the center of the screen and sparkle, then exit the 
scene from the lower right corner of the screen. Direction and special effects options are available from 
both the Motion Palette and the Object Options dialog box.

Note: You must use the Object Options dialog box to assign the Start/End and Path Editor options. 



Enter motion pop-up menu

Use this pop-up menu to select from which direction a selected object will enter the scene.



Enter transition pop-up menu

Use this pop-up menu to select a special effect that will occur when a selected object enters a scene.



Hold effect pop-up menu

Use this pop-up menu to select a display effect that will occur while a selected object is part of a scene.



Exit motion pop-up menu

Use this pop-up menu to select in which direction (if any) a selected object will exit the scene.



Exit transition pop-up menu

Use this pop-up menu to select a transition effect that will occur when a selected object exits a scene.



Timing bar

The timing bar shows the time that the selected object is scheduled to appear in the scene. This time is 
shown as a colored rectangular segment on the timing bar. Drag the ends of this segment to adjust the 
duration of the selected object.



Control panel

Click a control panel button for more information:

The control panel contains controls similar to those found on tape recorders. If the panel isn't visible, 
choose control panel from the Windows menu. 

The effects of the Rewind, Fast Forward, and Step controls can be specified in the Preferences dialog 
box. 



Playback controls

Use the playback controls to play, rewind, fast forward, stop, and step through the current scene or 
template. These have the same effect as the following commands from the Scene menu (click for more 
information):

Rewind
Step Backward
Stop
Step Forward
Play
Fast Forward



Time slider

Drag the time slider to quickly move through the scene. If the timeline is open, the playback head 
moves in concert with the time slider.



Point in Time and Span Time selectors (control panel)

The two buttons at the lower left of the control panel provide an easy way to switch between point-in-
time view (the left button) and span-time view (the right button). 



Current scene time

Current scene time shows the current time in the scene. Click the up and down arrows to the right of the 
current time to make small, incremental adjustments.



Timeline

The timeline allows you to synchronize the motion that takes place within a scene. The timeline shows 
the objects in the current scene and allows you to make many different adjustments, such as changing 
an object's duration by resizing its bar, reordering the layers in which objects appear, and changing the 
length of a scene.

Click an element of the timeline for more information:

Use the timeline to synchronize motion so that objects appear, perform, and disappear in a scene 
exactly when you want them to.

Related topic: Editing objects in the Timeline



Editing objects in the Timeline

You can edit objects in the timeline the same way you edit them in scene view. That is, you can:

- Click and hold an object bar with the right mouse button to display the Object Options menu, then 
choose an option.

- Click an object bar to select it, then choose Object Options from the Edit menu to display the Object 
Options dialog box.

Enter, exit, and hold durations

If an object has enter or exit durations set, lines appear in the object bar indicating the duration of those 
actions. 

To change an object's enter and exit durations directly in the timeline, select the object bar and drag 
either the left or right end of the bar. To increase or decrease the enter duration, drag the left end of the 
bar. To increase or decrease the exit duration, drag the right end of the bar. Hold duration remains the 
same.

To increase or decrease an object's Hold duration, select one of the vertical lines inside the bar and 
drag. Drag the line toward the end of the object to increase its hold duration. Drag toward the center of 
the object to decrease the hold duration. Enter and exit durations remain the same.

The Edit menu provides the standard Cut, Copy, and Paste commands for working with object bars. 
However, when you use these commands Action! also includes timing information when the object 
moves to and from the Clipboard. That is, when you cut or copy an object to the Clipboard, Action! 
copies all of the object's attributes, including enter, hold, and exit durations, links, and attached sounds. 
In addition, a time offset (the amount of time from the current scene time to the start time of the object) 
is also copied. The actual start time is not copied, just the amount of time between the scene time and 
the start time.

To specify or change scene options:

Choose Options from the Scene menu, or click with the right mouse button in an open area of the 
timeline.



Scale (timeline)

The time scale contains the playback head. It might also contain one or more pause controls and one or 
more sets of loop controls.

Time scale

The time scale measures scene timing. The end of scene marker is a heavy gray or black vertical line. 
Gray indicates a scene that is "As Long as Objects." Black indicates a fixed length scene.

Playback Head

The playback head marks the current scene time. It is present only when you work in point-in-time view; 
it is not visible when you work in span-time view. 

The playback head marks the position in the scene that is currently visible in the window. You can drag 
the playback to watch the motion take place in a scene. This fine control over playing a scene is a great 
way to make sure of the synchronization of the scene objects.

Tip: In point-in-time view, the playback head is not available because all the objects are visible at the 
same time.

Drag the playback head left and right in the time scale to change the current scene time. The scene 
normally changes as you move the playback head. Likewise, the playback head moves while the scene 
plays.



Grid (timeline)

Object bars appear in the timeline representing each object in a scene. If the scene uses a template, 
the timeline also contains bars representing the template objects. 

Scene objects appear in the upper part of the timeline and template objects in the lower part. (When 
you work in template view, only template objects appear in the timeline.) The scene divider line (a 
heavy, gray, horizontal line) separates scene objects from template objects.

Each object bar is:

- Color-coded for easy identification

- Labeled with an icon representing the object type (text, line, picture, and so forth)

- Labeled with the object name. 

Tip: If you plan to work with the timeline, give objects descriptive names for easy identification. 

Length of object bars

The length of an object's bar specifies its duration in the scene.

Horizontal position of object bars

The relative horizontal position of an object bar indicates when that object enters and exits a scene. You 
can drag an object bar horizontally to change its enter and exit times--however, you must drag the hold 
duration portion of the bar. Dragging the enter or exit segments, when present, shortens the hold 
duration.

Note: Dragging an object bar to the right changes the time duration if the scene time option is set to As 
Long as Objects. 

The order of object bars from top to bottom in the timeline indicates their order (or layer) in the scene. 
The object represented by the top bar is at the front of the scene, the next object occupies the second 
layer, and so on. You can change the order by dragging the bars up or down in the timeline. This 
functionality is similar to that provided by the Bring To Front, Send To Back, Bring Forward, and Send 
Backward commands in the Arrange menu. 

Movie objects always play in the front layer of the scene, no matter where they appear in the timeline.

Multiple object selection

To select more than one object bar at a time, hold down the Shift key while clicking to select the bars.



Scale selection (timeline)

You can use either the zoom tools or the time scale menu to change the time scale represented in the 
timeline.

To change the time scale representation, choose a measure from the time scale menu, or click one of 
the zoom tools.



Tool bar

Click an element of the toolbar for more information:

The tool bar buttons provide quick access to many commands and operations you use frequently. In all 
cases, you can access a command or operation represented on the tool bar using the menus.

You can remove (or, hide) the tool bar whenever you want extra room in your Action! window. Use the 
menus to access the tool bar functions while the tool bar is hidden.



Open presentation (tool bar)

Click this button to select the Open command from the File menu.



Save presentation (tool bar)

Click this button to select the Save command from the File menu.



New scene button (tool bar)

Click this button to select the New command from the Scene menu.



Select scene (tool bar)

Choose the scene you want to view by clicking the previous and next arrows or by selecting a scene 
from the drop-down list.



Use template drop-down list (tool bar)

When the template library you are using contains more than one template, you can switch between 
them using this drop-down list in the tool bar.

To apply templates to a scene, display the template drop list in the tool bar and choose a template:

- Action! lists the names of the templates available in the current library. A check mark indicates 
which template is applied to the current scene. 

- Choose No Template to remove all template material from the scene.

You can also choose a template from the Use Template submenu on the Scene menu. Using the menu 
gives you the option to use the template browser which allows you view a thumbnail picture of a 
template before apply it to a scene.



Demote/promote bullet buttons (tool bar)

Use these buttons to change the levels of the selected paragraph(s):

- Promote (the left button)--Moves the selected paragraph(s) up one level in the outline structure. 

- Demote (the right button)--Moves the selected paragraph(s) down one level in the outline structure. 

Text objects have an outline-type structure. Each line in a text object is assigned a level within the 
structure. Levels are important because they permit each level to function in its own unique way. 



Font size selector (tool bar)

Use the text size selector to specify the text size of selected text.



Text style buttons (tool bar)

Use these buttons to specify the text style (bold, italic, underline, shadow) of selected text.



Bullet on/off button (tool bar)

Use this button to add bullets to or delete bullets from the selected paragraphs.



Text Motion Gallery button (tool bar)

Use this button to open the text motion gallery for the selected text. This has the same effect as the 
Motion Gallery command on the Text menu.



Open/close timeline (tool bar)

Click this button to open or close the timeline window.



Stop scene (tool bar)

Click this button to stop the scene or template from playing.



Play scene (tool bar)

Click this button to play the current scene or template. Control-click to play in full screen mode.

Press Esc to stop the scene from playing.



Status bar

Click an element of the status bar for more information:

The status bar appears at the bottom of the scene window. Its contents change depending on what you 
are doing at the time.

When selecting an Action! command, tool, or button, the status bar displays help on using that 
command or interface element.



Status bar dynamic message area

This area of the status bar includes text describing the selected object. 



Scene duration indicator

This section of the status bar shows duration information for the selected object.



Current scene time indicator

This section of the status bar displays the current scene time. 



Full Screen command

Select this command to expand the current scene or template to full screen view. 

When in full screen view, the Action! menus are still accessible. They are hidden at the top of the 
screen. Click along the top of the screen to display and use the menus.



Help menu

Click a menu command for more information:



Topics command (Help menu)

Select the Help Topics command to open the Action! 3.0 Help window, which you are looking at now. 
When you select the Help Topics command, the Help window opens to an introductory screen, and 
there is an overview of the contents on the left side of the screen.

Related topics:Action! Help introduction
About Action! 3.0 Help



Pointer command (Help menu)

When you select the help pointer, the cursor changes to the help pointer cursor (like a question mark). 
Click on any part of the Action! interface (such as a menu command or part the tool bar) to get specific 
help on that part.

Hit the Esc key to cancel the help pointer.



About Action! command

Select this command to find out the Action! version number you are using. You can also see who was 
involved in creating this version of Action!




